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This Chapter Contains:

� An overview of GeneChip® Expression Analysis.

� A summary of the procedures covered in the remainder of the manual.
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SECTION 1   GeneChip® Expression Analysis Overview

1.1.4
Introduction and Objectives

Welcome to the Affymetrix GeneChip® Expression Analysis Technical Manual. This manual 
is a technical guide for using GeneChip® expression analysis probe arrays. All protocols 
included in this manual have been used successfully by scientists at Affymetrix, or have 
been recommended by our collaborators during the development of particular products. The 
field of mRNA gene expression monitoring is rapidly evolving and periodic technical 
updates to this manual will reflect the newest protocols and information for using 
GeneChip® probe arrays. This manual applies to all GeneChip® expression products.

As an Affymetrix GeneChip® user, your feedback is welcome. Please contact our technical 
support team with any input on how we can improve this resource.

Explanation of 
GeneChip® Probe Arrays

GeneChip® probe arrays are manufactured using technology that combines 
photolithography and combinatorial chemistry.1,2  Tens to hundreds of thousands of different 
oligonucleotide probes are synthesized on each array. Each oligonucleotide is located in a 
specific area on the array called a probe cell. Each probe cell contains millions of copies of 
a given oligonucleotide or probe.

Probe arrays are manufactured in a series of cycles. Initially, a glass substrate is coated with 
linkers containing photolabile protecting groups. Then, a mask is applied that exposes 
selected portions of the probe array to ultraviolet light. Illumination removes the 
photolabile protecting groups enabling selective nucleoside phosphoramidite addition only 
at the previously exposed sites. Next, a different mask is applied and the cycle of 
illumination and chemical coupling is performed again. By repeating this cycle, a specific 
set of oligonucleotide probes is synthesized with each probe type in a known location. The 
completed probe arrays are packaged into cartridges. 

During the laboratory procedure described in this manual, biotin-labeled RNA or cDNA 
fragments referred to as the “target” are hybridized to the probe array. The hybridized probe 
array is stained with streptavidin phycoerythrin conjugate and scanned by the GeneArray® 
Scanner at the excitation wavelength of 488 nm. The amount of light emitted at 570 nm is 
proportional to the bound target at each location on the probe array. 
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GeneChip® Expression 
Analysis Overview

The following major steps outline GeneChip® Expression Analysis:

1. Target Preparation 

2. Target Hybridization

3. Experiment and Fluidics Station Setup

4. Probe Array Washing and Staining

5. Probe Array Scan

6. Data Analysis

Due to the differences in the RNA species between eukaryotic and prokaryotic organisms, 
different target labeling protocols have been optimized for eukaryotic and E. coli samples. 
Sections 2 and 3 provide detailed protocols for target preparation, hybridization, array 
washing and staining for eukaryotic arrays and E. coli arrays, respectively. Please refer to 
the sections in this manual for detailed protocols appropriate for your arrays.

Step 1: Target Preparation

This manual describes procedures for preparing biotinylated target RNA or cDNA from 
purified eukaryotic and prokaryotic RNA samples suitable for hybridization to GeneChip® 
expression probe arrays. These procedures are recommendations only. For more 
information on these procedures, please contact Affymetrix Technical Support 
at 1-888-DNA-CHIP.

For eukaryotic samples, using protocols in this manual Section 2, double-stranded cDNA is 
synthesized from total RNA or purified poly(A)+ messenger RNA isolated from tissue or 
cells. An in vitro transcription (IVT) reaction is then done to produce biotin-labeled cRNA 
from the cDNA. The cRNA is fragmented before hybridization.

For E. coli samples, Section 3 describes a detailed protocol to isolate total RNA followed 
by enrichment of messenger RNA. After fragmentation, the RNA is end-modified and 
conjugated with biotin.

Step 2: Target Hybridization

A hybridization cocktail is prepared, including the fragmented target, probe array controls, 
BSA, and herring sperm DNA. It is then hybridized to the probe array during a 16-hour 
incubation. The hybridization process is described in the respective sections for the 
different probe array types.
1.1.5



SECTION 1   GeneChip® Expression Analysis Overview

1.1.6
Step 3: Experiment and Fluidics Station Setup

Specific experimental information is defined using Affymetrix® Microarray Suite on a 
PC-compatible workstation with a Windows NT operating system. The probe array type, 
sample description and comments are entered in Microarray Suite and saved with a unique 
experiment name. The fluidics station is then prepared for use by priming with the 
appropriate buffers. For more information on the fluidics station, refer to the GeneChip® 
Fluidics Station 400 User’s Guide.

Step 4: Probe Array Washing and Staining

Immediately following hybridization, the probe array undergoes an automated washing and 
staining protocol on the fluidics station.

Step 5: Probe Array Scan

Once the probe array has been hybridized, washed and stained, it is scanned. Each 
workstation running Affymetrix® Microarray Suite can control one scanner. Each probe 
array is scanned twice, taking up to ten minutes, depending on the array format. The 
software calculates an average of the two images, defines the probe cells and computes an 
intensity for each cell. The double scan improves assay sensitivity and reduces background 
noise.

Each complete probe array image is stored in a separate data file identified by the 
experiment name and is saved with a data image file (.dat) extension.

Review the scanner user’s manual for safety precautions and for more information on using 
the scanner.

Step 6: Data Analysis

Data is analyzed using Microarray Suite Expression Analysis window. The .dat image is 
analyzed for probe intensities; results are reported in tabular and graphical formats. 
Information on data analysis is given in Section 4.

Precautions

1. FOR RESEARCH USE ONLY; NOT FOR USE IN DIAGNOSTIC PROCEDURES.

2. Avoid microbial contamination, which may cause erroneous results.

3. Exercise standard precautions when obtaining, handling and disposing of potentially 
carcinogenic reagents.

4. Exercise care to avoid cross contamination of samples during all steps of this 
procedure, as this may lead to erroneous results.

5. Use powder-free gloves whenever possible to minimize introduction of powder 
particles into sample or probe array cartridges.

All biological specimens and materials with which they come into contact should be 
handled as if capable of transmitting infection and disposed of with proper 
precautions in accordance with federal, state and local regulations. This includes 
adherence to the OSHA Bloodborne Pathogens Standard (29 CFR 1910.1030) for 
blood-derived and other samples governed by this act. Never pipet by mouth. Avoid 
specimen contact with skin and mucous membranes.
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Terminology

Interfering Conditions

Proper storage and handling of reagents and samples is essential for robust performance.

All laboratory equipment used to prepare the target during this procedure should be 
calibrated and carefully maintained to ensure accuracy, as incorrect measurement of 
reagents may affect the outcome of the procedure.

Instruments

The Affymetrix GeneChip® Expression Analysis Technical Manual is designed for use in a 
system consisting of a GeneChip® Fluidics Station 400, a GeneChip® Hybridization Oven 
and a GeneArray® Scanner.

References

1. Sambrook, J., Fritsch, E.F., Maniatis, T. 1989. Molecular Cloning: A Laboratory 
Manual, v.1. Cold Spring Harbor, NY: Cold Spring Harbor Laboratory Press. p 21-52.

2. See www.affymetrix.com for current GeneChip technology references.

Limitations

� The results of the assay kit are dependent upon the quality of the input RNA, 
subsequent proper handling of nucleic acids and other reagents.

� The results should be evaluated by a qualified individual.

Probes The oligonucleotides on the surface of the probe arrays 
are called probes because they probe or interrogate the 
sample.

Target The target is the labeled nucleic acid that is being 
interrogated. It is hybridized to the probes on the array.

Probe Cell Specific areas on the probe array that contain 
oligonucleotides of a specific sequence.

Wear powder-free gloves throughout procedure. Take steps to minimize the 
introduction of exogenous nucleases. Water used in the protocols below is molecular 
biology-grade (nuclease-free).

Do not store enzymes in a frost-free freezer.
1.1.7
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Eukaryotic Target Preparation
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Step 1: First Strand cDNA Synthesis .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.1.14

Step 2: Second Strand cDNA Synthesis   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.1.16

Cleanup of Double-Stranded cDNA   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.1.17

Step 1: Phase Lock Gels (PLG)-Phenol/Chloroform Extraction  .  .  .  .  .  .  .  .  .  .  2.1.17

Step 2: Ethanol Precipitation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.1.17

Synthesis of Biotin-Labeled cRNA .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.1.19

Cleaning Up and Quantifying In Vitro Transcription (IVT) Products   .  .  .  .  .  .  .  .  2.1.20

Step 1: In Vitro Transcription Clean Up   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.1.20

Step 2: Ethanol Precipitation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.1.21

Step 3: Quantifying the cRNA (IVT Product)   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.1.21

Step 4: Checking Unfragmented Samples by Gel Electrophoresis .  .  .  .  .  .  .  .  .  2.1.22

Fragmenting the cRNA for Target Preparation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.1.22

This Chapter Contains:

� General Guidelines for extracting RNA from eukaryotic cells or tissues using 
commercially available reagents and kits.

� Detailed steps for making double-stranded cDNA from extracted RNA.

� The prepared cDNA is used for making biotinylated cRNA (target).

� Guidelines for producing biotin-labeled antisense cRNA (target) with in vitro transcription 
reaction (IVT) using the ENZO BioArray™ HighYield™ RNA Transcript Labeling Kit.

� Instructions for fragmenting the labeled cRNA target.

After completing the procedures described in this chapter, the labeled and fragmented 
cRNA target is hybridized to the probe array in Section 2, Chapter 3.
701025 rev 1 2.1.3
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

Total RNA Isolation
� TRIzol Reagent, Invitrogen Life Technologies, P/N 15596-018

� RNeasy Mini Kit, QIAGEN, P/N 74104

Poly (A)+ mRNA Isolation
� Oligotex Direct mRNA Kit (isolation of mRNA from whole cells), QIAGEN, P/N 72012, 

72022, or 72041

� Oligotex mRNA Kit (isolation of mRNA from total RNA), QIAGEN, P/N 70022, 70042, or 
70061

� Qiashredder, QIAGEN, P/N 79654 (Required only for use with QIAGEN Oligotex Direct 
Kit)

� DEPC-Treated Water, Ambion, P/N 9920

cDNA Synthesis
� SuperScript II, Invitrogen Life Technologies, P/N 18064-014  or 

SuperScript Choice System for cDNA Synthesis, Invitrogen Life Technologies, P/N 
18090-019

� T7– (dT)24 Primer, Genset Corp or Operon, HPLC purified DNA
5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(dT)24 - 3´, 100 pmol/µL

� E. coli DNA Ligase, Invitrogen Life Technologies, P/N 18052-019

� E. coli DNA Polymerase I, Invitrogen Life Technologies, P/N 18010-025

� E. coli RNaseH, Invitrogen Life Technologies, P/N 18021-071

� T4 DNA Polymerase, Invitrogen Life Technologies, P/N 18005-025

� 5X Second strand buffer, Invitrogen Life Technologies, P/N 10812-014

� 10 mM dNTP, Invitrogen Life Technologies, P/N 18427-013

� Phase Lock Gel, Brinkman Instrument, P/N 0032007961 for 200

� Phenol/chloroform/isoamyl alcohol, Ambion, P/N 9732

Do not store enzymes in a frost-free freezer.

SuperScript Choice System contains, in addition to SuperScript II Reverse 
Transcriptase, other reagents for cDNA synthesis.  However, not all components 
provided in the Choice System are used in the GeneChip cDNA synthesis protocol.
2.1.5

http://www.invitrogen.com/
http://www.qiagen.com
http://www.qiagen.com
http://www.qiagen.com
http://www.qiagen.com
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http://www.invitrogen.com/
http://www.invitrogen.com/
http://www.invitrogen.com/
http://www.invitrogen.com/
http://www.invitrogen.com/
http://www.ambion.com
http://www.invitrogen.com/
http://www.operon.com
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2.1.6
Synthesis of Biotin-Labeled cRNA

IVT cRNA Cleanup and Quantitation
� RNeasy Mini Kit (used in IVT cleanup), QIAGEN, P/N 74103, 74104, 74106, or

CHROMA SPIN-100 Columns in Swing Bucket Format, CLONTECH, P/N K1302-1 
(optional)

� DEPC-Treated water, Ambion, P/N 9920

� 10X TBE, BioWhittaker, P/N 16-012Y

cRNA Fragmentation
� Trizma Base, Sigma-Aldrich, P/N T1503

� Magnesium acetate (MgOAc), Sigma-Aldrich, P/N M2545

� Potassium acetate (KOAc), Sigma-Aldrich, P/N P5708

� Glacial Acetic Acid, Sigma-Aldrich, P/N A628

Miscellaneous Reagents
� 7.5 M Ammonium Acetate (NH4OAc), Sigma-Aldrich, P/N A2706

� Absolute ethanol (stored at -20°C)

� 80% ethanol (stored at -20°C)

� SYBR Green II, FMC Bioproducts, P/N 50523; or Molecular Probes, P/N S7586 (optional)

� Water, Molecular Biology Grade, BioWhittaker, P/N 16-001Y

� Pellet Paint, Novagen, P/N 69049-3 (optional)

� Glycogen, Ambion, P/N 9510 (optional)

� 3 M Sodium Acetate (NaOAc), Sigma-Aldrich, P/N S7899

� Ethidium Bromide, Sigma-Aldrich, P/N E8751

� NaOH (1 N)

� HCl (1 N)

� 50 mM MgCl2     

� 0.5 M EDTA

Miscellaneous Supplies
� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific, P/N 1415-2600 (or 

equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman or equivalent

� Sterile-barrier, RNase-free pipette tips (Tips must be pointed, not rounded, for efficient 
use with the probe arrays)

� Mini agarose gel electrophoresis unit with appropriate buffers

� Vacuum filter units (1 liter capacity, 0.22 µm or 0.45 µm), VWR Scientific Products, P/N 
28199-730

� UV spectrophotometer

� Heatblock

� Cooling waterbath

RNA Transcript Labeling Kit, Affymetrix, P/N 900182Enzo
BioArray

HighYield

http://www.affymetrix.com
http://www.qiagen.com
http://www.clontech.com
httP://www.ambion.com
http://www.biowhittaker.com
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.fmc.com
http://www.biowhittaker.com
http://www.novagen.com
httP://www.ambion.com
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.usascientific.com
httP://www.vwrsp.com
http://www.sigma-aldrich.com
http://www.probes.com
http://www.rainin.com
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Reagent Preparation

5X RNA Fragmentation Buffer 
(200 mM Tris-acetate, pH 8.1, 500 mM KOAc, 150 mM MgOAc)

The fragmentation buffer is made with RNase-free reagents. Tris-containing solutions 
should not be treated with DEPC; however, once H20 has been DEPC-treated and 
autoclaved it can be used for making the Tris solution.

1. Combine the following components to a total volume of 20 mL.

� 4.0 mL 1 M Tris acetate pH 8.1 (Trizma Base, pH adjusted with glacial acetic acid)

� 0.64 g MgOAc

� 0.98 g KOAc

� DEPC-treated H20 to 20 mL

2. Mix thoroughly and filter through a 0.2 µm vacuum filter unit. This reagent should be 
aliquotted and stored at room temperature.
2.1.7
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Isolation of RNA

Protocols are provided for preparing labeled cRNA from either total RNA or purified 
poly(A)+ mRNA. We have found that results obtained from samples prepared by both of 
these methods are similar, but not identical. Therefore, to get the best results we suggest 
only comparing samples prepared using the same type of RNA material.

Please review precautions and interfering conditions in Section 1.
 

When using a commercial kit, follow the manufacturer’s instructions for RNA isolation.

Isolation of RNA From Yeast

Total RNA

We have successfully isolated good quality total RNA from yeast cells using a hot phenol 
protocol described by Schmitt, et al. (1990) Nucl Acids Res, 18:3091-3092.

Poly(A)+ mRNA

Affymetrix recommends first purifying total RNA from yeast cells before isolating 
poly(A)+ mRNA from total RNA. Good quality mRNA has been successfully isolated from 
total RNA using QIAGEN’s Oligotex mRNA kit. A single round of poly(A)+ mRNA 
selection provides mRNA of sufficient purity and yield to use as a template for cDNA 
synthesis. Two rounds of poly(A)+ mRNA selection will result in significantly reduced 
yields of yeast mRNA and is not generally recommended.

Isolation of RNA from Arabidopsis

Total RNA

We have been using TRIzol Reagent from Invitrogen Life Technologies to isolate total 
RNA from Arabidopsis. Please follow the instructions provided by the supplier and, when 
necessary, use the steps outlined specifically for samples with high starch and/or high lipid 
content.

Poly(A)+ mRNA

We have successfully isolated Arabidopsis poly(A)+ RNA using QIAGEN Oligotex 
product. However, other standard isolation products are likely to be adequate.

The quality of the RNA is essential to the overall success of the analysis. Since the 
most appropriate protocol for the isolation of RNA can be source-dependent, we 
recommend using a protocol that has been established for the tissues or cells being 
used. In the absence of an established protocol, we suggest using one of the 
commercially available kits designed for RNA isolation.
2.1.9
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Isolation of RNA from Mammalian Cells or Tissues

Total RNA

We have successfully isolated good quality total RNA from mammalian cells (such as 
cultured cells and lymphocytes) using QIAGEN’s RNeasy Total RNA Isolation kit.

If mammalian tissue is used as the source of RNA, we recommend isolating total RNA with 
a commercial reagent such as TRIzol.

Poly(A)+ mRNA

Good quality mRNA has been successfully isolated from mammalian cells (such as 
cultured cells and lymphocytes) using QIAGEN’s Oligotex Direct mRNA kit and from total 
RNA using the Oligotex mRNA kit. If mammalian tissue is used as the source of mRNA, 
total RNA should be first purified using a commercial reagent such as TRIzol and then 
using a poly(A)+ mRNA isolation procedure or a commercial kit.

Precipitation of RNA

Total RNA

It is not necessary to precipitate total RNA following isolation or cleanup with RNeasy 
Total RNA Isolation kit. Please adjust elution volumes from the RNeasy column to prepare 
for cDNA synthesis based upon expected RNA yields from your experiment.

Ethanol precipitation is required following TRIzol isolation and hot phenol extraction 
methods; see methods below.

Poly(A)+ mRNA

Most poly(A)+ mRNA isolation procedures will result in dilute solutions of RNA. It is 
necessary to concentrate mRNA prior to the cDNA synthesis.

Precipitation Procedure

1. Add 1/10 volume 3 M NaOAc, pH 5.2, and 2.5 volumes ethanol.*

2. Mix and incubate at -20°C for at least 1 hour.

3. Centrifuge at ≥ 12,000 x g in a microcentrifuge for 20 minutes at 4°C.

If going directly from TRIzol isolated total RNA to cDNA synthesis, it may be beneficial to 
perform a second cleanup on the total RNA before starting. After the ethanol precipitation 
step in the TRIzol extraction procedure, perform a cleanup using QIAGEN RNeasy Total 
RNA isolation kit. Much better yields of labeled cRNA are obtained from the in vitro 
transcription-labeling reaction when this second cleanup is performed.

Affymetrix recommends starting the cDNA synthesis protocol with a minimum of 
0.2 µg poly(A)+ mRNA at a minimum concentration of 0.02 µg/µL, or 5 µg of total RNA 
at a minimum concentration of 0.5 µg/µL, in order to obtain sufficient quantity of 
labeled cRNA for target assessment and hybridization to GeneChip® expression 
probe arrays. There are two major advantages to starting with at least the 
recommended amount of material:

1. Enough material to check sample yield and quality at the various steps of this 
protocol.

2. Production of enough cRNA for hybridization of the target to multiple probe arrays.
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4. Wash pellet twice with 80% ethanol.

5. Air dry pellet. Check for dryness before proceeding.

6. Resuspend pellet in DEPC-treated H2O. The appropriate volume for resuspension 
depends on the expected yield and the amount of RNA required for the cDNA 
synthesis. Please read ahead to the cDNA synthesis protocol in order to determine the 
appropriate resuspension volume at this step.

*Addition of Carrier to Ethanol Precipitations

Adding carrier material has been shown to improve the RNA yield of precipitation 
reactions.

� Pellet Paint

Affymetrix has found that adding 0.5 µL of Pellet Paint per tube to nucleic acid 
precipitations makes the nucleic acid pellet easier to visualize and helps reduce the 
chance of losing the pellet during washing steps. The pellet paint does not appear to 
affect the outcome of subsequent steps in this protocol; however, it can contribute to 
the absorbance at 260 nm when quantifying the mRNA. 

� Glycogen

Addition of 0.5 to 1 µL of glycogen (5 mg/mL) to nucleic acid precipitations aids in 
visualization of the pellet and may increase recovery. The glycogen does not appear to 
affect the outcome of subsequent steps in this protocol. 

Quantitation of RNA

Quantify RNA yield by spectrophotometric analysis using the convention that 1 absorbance 
unit at 260 nm equals 40 µg RNA per mL.

� The absorbance should be checked at 260 and 280 nm for determination of sample 
concentration and purity. 

� The A260/A280 ratio should be close to 2.0 for pure RNA (ratios between 1.9 and 2.1 are 
acceptable).
2.1.11
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Synthesis of Double-Stranded cDNA 

From Purified Poly(A)+ mRNA1

This protocol is a supplement to instructions provided in Invitrogen Life Technologies 
SuperScript Choice system. Please note the following before proceeding:

� Read all information and instructions that come with reagents and kits.

� Use the T7-(dT)24 oligomer (described below) for priming first-strand cDNA synthesis in 
place of the oligo (dT) or random primers provided with the SuperScript kit.

� It is recommended that each step of this protocol be checked by gel electrophoresis.

T7-(dT)24 primer:

5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(dT)24 - 3´

Step 1: First Strand cDNA Synthesis

Starting material: High quality poly(A)+ mRNA (0.2 µg to 5 µg)

Before starting cDNA synthesis, the correct volumes of DEPC-treated H2O and Reverse 
Transcriptase (RT) must be determined. These volumes will depend on both the 
concentration and total volume of mRNA that is being added to the reaction. For every µg 
of mRNA, you will need to add 1 µL of SuperScript II RT (200 U/µL). For mRNA quantity 
≤ 1 µg, use 1 µL of SuperScript II RT. Synthesis reactions should be done in a 
polypropylene tube (RNase-free).

Affymetrix strongly recommends HPLC purification of the T7-(dT)24 primer.

High quality, HPLC-purified T7-(dT)24 primer is essential not only for double-stranded 
cDNA synthesis, but also for the in vitro transcription (IVT) reaction. Insufficiently 
purified primer may appear to produce double-stranded cDNA efficiently (since the 
5´ end of the primer is not critical for the priming step), but still result in poor IVT 
yields if the primer is contaminated with shorter sequences (missing the 5´end which 
contains the promoter region for the IVT reaction).  
PAGE-purified primers do not generally work well in this protocol.

Use Table 2.1.1 for variable component calculations. Determine volumes of mRNA 
and SuperScript II RT required, and then calculate the amount of DEPC-treated H2O 
needed in the Primer Hybridization Mix step to bring the final First Strand 
Synthesis reaction volume to 20 µL.
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Step 2: Second Strand cDNA Synthesis

1. Place First Strand reactions on ice. Centrifuge briefly to bring down condensation on 
sides of tube.

2. Add to the First Strand synthesis tube the reagents listed in the following Second 
Strand Final Reaction Composition Table (Table 2.1.2).

3. Gently tap tube to mix. Then, briefly spin in a microcentrifuge to remove condensation 
and incubate at 16°C for 2 hours in a cooling waterbath.

4. Add 2 µL [10 U] T4 DNA Polymerase.

5. Return to 16°C for 5 minutes.

6. Add 10 µL 0.5 M EDTA.

7. Proceed to clean-up procedure for cDNA, Cleanup of Double-Stranded cDNA on 
page 2.1.17, or store at -20°C for later use. 

Table 2.1.1

First Strand cDNA Synthesis Components

Reagents in Reaction Volume

Final Concentration 

or Amount in 

Reaction

1: Primer Hybridization
Incubate at 70° C for 10 minutes
Quick spin and put on ice

DEPC- H2O (variable) 
T7-(dT)24 primer (100 pmol/µL)
mRNA (variable)

for final reaction volume of 20 µL
1 µL

0.2 to 5 µg
100 pmol

0.2 to 5 µg

2: Temperature Adjustment
Add to the above tube and mix well
Incubate at 37° C for 2 minutes

5X First strand cDNA buffer
0.1 M DTT
10 mM dNTP mix

4 µL
2 µL
1 µL

1X
10 mM 

500 µM each

3: First Strand Synthesis
Add to the above tube and mix well 
Incubate at 37° C for 1hour

SuperScript II RT 
(variable) (200 U/µL)

1 µL per µg mRNA 200 U to 1000 U

Total Volume   20 µL

Table 2.1.2

 Second Strand Final Reaction Composition 

Component Volume
Final Concentration or 

Amount in Reaction

DEPC-treated water 91 µL

5X Second Strand Reaction Buffer 30 µL 1X

10 mM dNTP mix 3 µL 200 µM each

10 U/µL E. coli  DNA Ligase 1 µL 10 U

10 U/µL E. coli  DNA Polymerase I 4 µL 40 U

2 U/µL E. coli  RNase H 1 µL 2 U 

Final Volume 150 µL
2.1.13
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2.1.14
Synthesis of Double-Stranded cDNA 
from Total RNA

This protocol is a supplement to instructions provided in Invitrogen Life Technologies 
SuperScript Choice system. Please note the following before proceeding:

� Read all information and instructions that come with reagents and kits.

� Use the T7-(dT)24 oligomer (described below) for priming first-strand cDNA synthesis in 
place of the oligo (dT) or random primers provided with the SuperScript kit.

� It is recommended that each step of this protocol be checked by gel electrophoresis.

T7-(dT)24 primer

5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(dT)24 - 3´

Step 1:  First Strand cDNA Synthesis

Starting material: High quality total RNA (5.0 µg - 40.0 µg)

After purification the RNA concentration is determined by absorbance at 260 nm on a 
spectrophotometer (one absorbance unit = 40 µg/mL RNA). The A260/A280 ratio should be 
approximately 2.0, with ranges between 1.8 to 2.1 considered acceptable. We recommend 
checking the quality of the RNA by running it on an agarose gel prior to starting the assay.  
The rRNA bands should be clear without any obvious smearing patterns.

Before starting cDNA synthesis, the correct volumes of DEPC-treated H2O and Reverse 
Transcriptase (RT) must be determined. These volumes will depend on both the 
concentration and total volume of RNA that is being added to the reaction.

Affymetrix strongly recommends HPLC purification of the T7-(dT)24 primer.

High quality, HPLC-purified T7-(dT)24 primer is essential not only for double-stranded 
cDNA synthesis, but also for the in vitro transcription (IVT) reaction. Insufficiently 
purified primer may appear to produce double-stranded cDNA efficiently (since the 5´ 
end of the primer is not critical for the priming step), but still result in poor IVT yields 
if the primer is contaminated with shorter sequences (missing the 5´end which 
contains the promoter region for the IVT reaction). 
PAGE-purified primers do not generally work well in this protocol.

Use Table 2.1.3 and Table 2.1.4 for variable component calculations. Determine the 
volumes of RNA and SuperScript II RT required in Table 2.1.3, then calculate the 
amount of DEPC-treated H2O needed in Step 1 Table 2.1.4 to bring the final volume in 
Step 3 Table 2.1.4 to 20 µL.
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Synthesis reactions should be done in a 1.5 mL polypropylene tube (RNase-free).

Table 2.1.3

Reverse Transcriptase Volumes for First Strand cDNA Synthesis Reaction

Total RNA (µg) SuperScript II RT (µL), 200U/µL

      5.0 to 8.0 1.0

      8.1 to 16.0 2.0

    16.1 to 24.0 3.0

    24.1 to 32.0 4.0

    32.1 to 40.0 5.0

The combined volume of RNA and SuperScript II RT should not exceed 12 µL as 
indicated in Table 2.1.4.

Table 2.1.4

First Strand cDNA Synthesis Components

Reagents  in reaction Volume
Final concentration 

or amount in reaction

1: Primer Hybridization 
Incubate at 70° C for 10 minutes
Quick spin and put on ice

DEPC- H2O (variable) 
T7-(dT)24 primer (100 pmol/µL)
RNA (variable)

for final reaction volume of 20 µL
1 µL

5.0 to 40 µg
100 pmol

5.0 to 40 µg

2: Temperature Adjustment
Add to the above tube and mix well 
Incubate at 42° C for 2 minutes

5X First strand cDNA buffer
0.1 M DTT
10 mM dNTP mix

4 µL
2 µL
1 µL

1X
10 mM DTT
500 µM each

3: First Strand Synthesis
Add to the above tube and mix well
Incubate at 42° C for 1 hour

SuperScript II RT (variable)
(200 U/µL)

See Table 2.1.3 200 U to 1000 U

Total Volume   20 µL

The above incubations have been changed from the SuperScript protocols and are 
done at 42°C.
2.1.15
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Step 2: Second Strand cDNA Synthesis

1. Place First Strand reactions on ice. Centrifuge briefly to bring down condensation on 
sides of tube.

2. Add to the First Strand synthesis tube the reagents listed in the following Second 
Strand Final Reaction Composition Table (Table 2.1.5).

3. Gently tap tube to mix. Then, briefly spin in a microcentrifuge to remove condensation 
and incubate at 16°C for 2 hours in a cooling waterbath.

4. Add 2 µL [10 U] T4 DNA Polymerase.

5. Return to 16°C for 5 minutes.

6. Add 10 µL 0.5 M EDTA.

7. Proceed to clean-up procedure for cDNA, Cleanup of Double-Stranded cDNA on 
page 2.1.17, or store at -20°C for later use. 

Table 2.1.5

 Second Strand Final Reaction Composition 

Component Volume
Final Concentration or 

Amount in Reaction

DEPC-treated water 91 µL

5X Second Strand Reaction Buffer 30 µL 1X

10 mM dNTP mix 3 µL 200 µM each

10 U/µL E. coli DNA Ligase 1 µL 10 U

10 U/µL E. coli  DNA Polymerase I 4 µL 40 U

2 U/µL E. coli  RNase H 1 µL 2 U 

Final Volume 150 µL
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Cleanup of Double-Stranded CDNA

Step 1: Phase Lock Gels (PLG)-Phenol/Chloroform Extraction

Phase Lock Gels (PLG) form an inert, sealed barrier between the aqueous and organic 
phases of phenol-chloroform extractions. The solid barrier allows more complete recovery 
of the sample (aqueous phase) and minimizes interface contamination of the sample. PLG’s 
are sold as premeasured aliquots in 1.5 mL tubes to which sample and phenol chloroform 
are directly added.

1. Pellet the Phase Lock Gel (1.5 mL tube with PLG I - heavy) in a microcentrifuge at 
≥ 12,000 x g for 20 to 30 seconds.

2. Add 162 µL (equal volume) of (25:24:1) Phenol:chloroform:isoamyl alcohol (saturated 
with 10 mM Tris-HCl pH 8.0, 1 mM EDTA) to the final cDNA synthesis preparation 
(162 µL) to a final volume of 324 µL. Vortex briefly.

(See Reagents and Materials Required on page 2.1.5 for ordering information for 
phenol:chloroform:isoamyl alcohol.)

3. Transfer the entire cDNA-phenol/chloroform mixture to the PLG tube.

4. DO NOT VORTEX. PLG will now become part of the suspension. Microcentrifuge at 
full speed (≥ 12,000 x g) for 2 minutes.

5. Transfer the aqueous upper phase to a fresh 1.5 mL tube.

Step 2: Ethanol Precipitation

Please refer to Precipitation of RNA on page 2.1.10 for information on the use of carriers 
during ethanol precipitation.

1. Add 0.5 volumes of 7.5 M NH4OAc and 2.5 volumes of absolute ethanol (stored at 
-20°C) to the sample and vortex.

2. Immediately centrifuge at ≥ 12,000 x g in a microcentrifuge at room temperature for 
20 minutes.

3. Remove supernatant. Wash pellet with 0.5 mL of 80% ethanol (stored at -20°C).

4. Centrifuge at ≥ 12,000 x g at room temperature for 5 minutes.

5. Remove the 80% ethanol very carefully; the pellet may be loose. Repeat the 80% 
ethanol wash one additional time.

6. Air dry the pellet. Check pellet for dryness before proceeding.

7. Resuspend dried pellet in a small volume of RNase-free water. We recommend 
resuspending in 12 µL.

A standard phenol/chloroform extraction can be performed as an alternative to the 
PLG  procedure.

Store phenol:chloroform:isoamyl alcohol at 4°C.  Dispose of solution when it turns 
pink.
2.1.17
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8. An aliquot of the cDNA prepared from isolated poly(A)+ can be analyzed for size 
distribution and yield on a 1% agarose gel. One µL of double-stranded cDNA should be 
sufficient to detect on an agarose gel stained with ethidium bromide. A representative 
gel is shown in Figure 1.2 on page 2.1.23. We do not recommend gel analysis for cDNA 
prepared from total RNA.

9. After clean-up please proceed to Synthesis of Biotin-Labeled cRNA on page 2.1.19.

The appropriate volume for resuspension depends on expected yield. In the next step 
of sample preparation, Synthesis of Biotin-Labeled cRNA, it is recommended to start 
with approximately 1 µg of cDNA (up to 22 µL of volume is available in the in vitro 
transcription reaction). Please see Tables 2.1.6 and 2.1.7 for recommendations.

Also, we do not recommend RNase treatment of the cDNA prior to the in vitro 
transcription and labeling reaction; the carry-over ribosomal RNA does not seem to 
inhibit the reaction.

Quantifying the amount of double-stranded cDNA by the absorbance at 260 nm is 
not recommended. The primer can contribute significantly to the absorbance. 
Subtracting the theoretical contribution of the primer based on the amount added to 
the reaction is not practical, because it is not likely to precipitate as reproducibly and 
efficiently as the longer double-stranded cDNAs.
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Synthesis of Biotin-Labeled cRNA

For instructions regarding the labeling of RNA transcripts, 
please refer to the BioArray HighYield RNA Transcript 
Labeling Kit, Affymetrix, P/N 900182.

Overnight incubation may produce shorter products.

Table 2.1.6 

cDNA in IVT (Total RNA)

Total RNA (µg) Volume of cDNA to use in IVT*

5.0 to 8.0         10 µL

8.1 to 16.0         5 µL

16.1 to 24.0         3.3 µL

24.1 to 32.0         2.5 µL

32.1.to 40.0.         2 µL

* assuming 12 µL resuspension volume for DNA, as previously described. 

Table 2.1.7 

cDNA in IVT (Poly(A)+ RNA)

Poly(A)+ RNA (µg) Volume cDNA*

0.2 - 0.5         10 µL

0.6 - 1.0         8 µL

1 - 2         5 µL

3 - 5         2 µL

* assuming 12 µL resuspension volume for DNA, as previously described.

Enzo
BioArray

HighYield
2.1.19
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2.1.20
Cleaning Up and Quantifying 
In Vitro Transcription (IVT) Products

Step 1: In Vitro Transcription Clean Up

� It is essential to remove unincorporated NTPs, so that the 260 nm absorbance can 
determine the quantity of cRNA.

� DO NOT extract biotin-labeled RNA with phenol-chloroform. The biotin will cause some 
of the RNA to partition into the organic phase. This will result in low yields.

� Save an aliquot of the unpurified IVT product for analysis by gel electrophoresis.

� We suggest purifying one-half of the IVT reaction product and checking yields before 
purifying the second half for two reasons:

a. If the sample is lost during the purification, the second portion can be used.

b. When IVT product yields are high, the amount of RNA in the whole reaction may 
exceed the capacity of the device used for purification. Therefore, purifying one-half 
of the reaction may result in better overall yields.

Recommended Methods for In Vitro Transcription Clean Up

1. RNeasy spin columns from QIAGEN (preferred method).

2. CHROMA SPIN-100 (size exclusion spin columns) + EtOH precipitation.

IVT Cleanup Protocol Using QIAGEN RNeasy Columns

Follow the instructions for RNA cleanup from the QIAGEN handbook included in every 
kit. Depending on recovery, ethanol precipitation may be required to concentrate cRNA 
(see Step 2: Ethanol Precipitation on page 2.1.21).

Suggestions for Increased Yield

1. Pass the sample over the column two times before the wash and elution steps.

2. After adding water to the column for RNA elution, wait one minute before 
centrifuging.

IVT Cleanup Protocol Using CHROMA SPIN-100s and Ethanol Precipitation

Follow the CHROMA SPIN protocol with the following modifications:

1. Bring the volume of the IVT reaction to 100 µL with RNase-free water.

2. Load 50 µL (half) of sample onto column.

3. Wash the column with an additional 50 µL of RNase-free H2O and combine with 
sample flow-through.

The minimum concentration for purified cRNA is 0.6 µg/µL for the following 
fragmentation reaction in Fragmenting the cRNA for Target Preparation on 
page 2.1.22.



CHAPTER 1   Eukaryotic Target Preparation

E
u

k
a
ry

o
ti

c

Step 2: Ethanol Precipitation

1. Add 0.5 volumes of 7.5 M NH4OAc and 2.5 volumes of absolute ethanol (stored at 
-20°C) to the sample and vortex.

2. Precipitate at -20°C for 1 hour to overnight.

3. Centrifuge at ≥ 12,000 x g at 4°C for 30 minutes.

4. Wash pellet twice with 0.5 mL of 80% ethanol (stored at -20°C). Air dry the pellet and 
check for dryness before resuspension.

5. Resuspend dried pellet in 10 to 20 µL of RNase-free water.

Step 3: Quantifying the cRNA (IVT Product)

Use spectrophotometric analysis to determine the cRNA yield. Apply the convention that 
1 absorbance unit at 260 nm equals 40 µg/mL RNA. 

� Check the absorbance at 260 nm and 280 nm to determine sample concentration and 
purity. 

� Maintain the A260/A280 ratio close to 2.0 for pure RNA (ratios between 1.9 and 2.1 are 
acceptable).

For quantification of cRNA when using total RNA as starting material, an adjusted cRNA 
yield must be calculated to reflect carryover of unlabeled total RNA. Using an estimate of 
100% carryover, use the formula below to determine adjusted cRNA yield:

adjusted cRNA yield = RNAm - (total RNAi)(y)

RNAm = amount of cRNA measured after IVT (µg)
total RNAi = starting amount of total RNA (µg)
y = fraction of cDNA reaction used in IVT

Example: Starting with 10 µg total RNA, 50% of the cDNA reaction is added to the IVT, 
giving a yield of 50 µg cRNA. Therefore, adjusted cRNA yield = 50 µg cRNA - (10 µg total 
RNA) (0.5 cDNA reaction) = 45.0 µg.

Use adjusted yield in, Eukaryotic Target Hybridization on page 2.3.3.

Required for CHROMA SPIN-100 method. Optional step after RNeasy method, to 
increase concentration to the minimum requirement of 0.6 µg/µL for fragmentation.

If 1 µg cDNA template was used in the IVT reaction, expect 30 to 50 µg cRNA for 
one-half IVT reaction.

Please refer to Table 2.3.1 on page 2.3.7 for the amount of cRNA required for one 
array hybridization experiment. The amount varies depending on the array format. 
Please refer to a specific probe array package insert for information on the array 
format.
2.1.21
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2.1.22
Step 4: Checking Unfragmented Samples by Gel Electrophoresis

Gel electrophoresis of the IVT product is done to estimate the yield and size distribution of 
labeled transcripts. Parallel gel runs of unpurified and purified IVT product can help 
determine the extent of a loss of sample during the clean-up process. 

� Analyze 1% of each sample by gel electrophoresis through a 1% agarose gel.

� Mix RNA (samples or markers) with loading dye and heat to 65°C for 5 minutes before 
loading on the gel. 

� Ethidium bromide can be used to visualize the RNA in the gel.
Alternatively, gels can be stained with SYBR Green II at a 1:10,000 dilution in 1X TBE 
buffer. SYBR Green II stains single-stranded RNA with greater sensitivity than ethidium 
bromide, but it requires a special photographic filter available from Molecular Probes to 
photograph stained bands.

� As an option, run a denaturing gel to obtain a more accurate estimation of the RNA size 
distribution.

Fragmenting the cRNA 
for Target Preparation

Affymetrix recommends that the RNA used in the fragmentation procedure be sufficiently 
concentrated to maintain a small volume during the procedure. This will minimize the 
amount of magnesium in the final hybridization cocktail. The cRNA must be at a minimum 
concentration of 0.6 µg/µL. If it is not, it can be precipitated with ethanol using the protocol 
in this chapter, Cleaning Up and Quantifying In Vitro Transcription (IVT) Products, Step 2: 
Ethanol Precipitation on page 2.1.21. It can then be resuspended in a smaller volume of 
RNase-free water. Fragment an appropriate amount of cRNA for hybridization cocktail and 
gel analysis (see Section 2, Chapter 3, Table 2.3.1).

1. Add 2 µL of 5X Fragmentation Buffer for every 8 µL of RNA plus H2O. The 
fragmentation buffer has been optimized to break down full length cRNA to 35-200 
bases fragments by metal-induced hydrolysis.

The final concentration of RNA in the fragmentation mix can range from 0.5 µg/µL to 
2 µg/µL. The following table shows an example of a fragmentation mix for a 20 µg 
cRNA sample at a final concentration of 0.5 µg/µL. 

For fragmentation, use adjusted cRNA concentration, as described in Step 3: 
Quantifying the cRNA (IVT Product) on page 2.1.21.

Example for 0.5 µg/µL final concentration:

Table 2.1.8 

Example of Fragmentation Reaction

Component Volume

    20 µg cRNA 1 to 32 µL

    5X Fragmentation
    Buffer

8 µL

    RNase-free water to 40 µL

http://www.probes.com
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2. Incubate at 94°C for 35 minutes. Put on ice following the incubation. 

3. Save an aliquot for gel analysis.

At least 1 µg fragmented cRNA is needed if using ethidium bromide for staining the 
gel. Less RNA can be used with SYBR Green II staining. See Step 4: Checking 
Unfragmented Samples by Gel Electrophoresis on page 2.1.22, for information 
regarding gel electrophoresis. The standard fragmentation procedure should produce a 
distribution of RNA fragment sizes from approximately 35 to 200 bases. An example 
of a gel with cRNA samples before and after fragmentation is shown below.

4. Store undiluted, fragmented sample RNA at -20°C until ready to perform the 
hybridization, as described in Section 2, Chapter 3.

Figure 1.2    

Monitoring of target preparation by agarose gel electrophoresis
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2.1.24
1 Incyte Genomics, Inc. has asserted that the use of this protocol within the United States infringes U.S. Patent 
Nos. 5,716,785 and 5,891,636. Affymetrix and Incyte Genomics, Inc. are currently litigating this and related 
issues. Use of this protocol outside the United States does not infringe these patents. To the extent that users of 
this protocol wish to seek a license of these patents for use in the United States, they may contact Incyte 
Genomics, Inc., 3160 Porter Drive, Palo Alto, California 94304.
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Preparation of Controls for Eukaryotic Arrays

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.2.5

Hybridization Control Kit .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.2.7

Poly(A)+ Spike Controls   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.2.7

This Chapter Contains:

� General guidelines for producing controls for eukaryotic arrays.

After completing the procedures described in this chapter, the control transcripts are 
combined in variable concentrations before adding to the target hybridization mix as 
explained in Section 2, Chapter 3.
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Reagents and Materials Required 

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

GeneChip® Eukaryotic Hybridization Control Kit (Complete Kit)
� Affymetrix, P/N 900299

Poly(A)+ Spike Controls
� pGIBS-lys ATCC 87482

� pGIBS-phe ATCC 87483

� pGIBS-thr ATCC 87484

� pGIBS-trp ATCC 87485

� pGIBS-dap ATCC 87486
2.2.5
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Hybridization Control Kit

Each commercially available eukaryotic probe array contains probe sets for several 
prokaryotic genes. BioB, bioC, and bioD are genes of the biotin synthesis pathway from the 
bacteria E.coli, and cre is the recombinase gene from P1 bacteriophage. These genes can be 
labeled and serve as hybridization controls when mixed with labeled eukaryotic cRNA 
samples. 

Affymetrix provides a kit that contains a 20X reagent with pre-mixed hybridization control 
transcripts (bioB, bioC, bioD, and cre) in variable concentrations. These controls are ready 
to be added to the hybridization mix, as described in Section 2, Chapter 3. 
A 60X stock of the B2 control oligo is also provided in the kit. For instructions on using the 
GeneChip® Eukaryotic Hybridization Control Kit (P/N 900299), please refer to the package 
insert and the updated instructions in Section 2, Chapter 3 for more detailed information.

Poly(A)+ Spike Controls

Five poly(A)+-tailed control clones encoding B. subtilis genes (dap, thr, trp, phe, lys) are 
cloned into pBluescript as an Xho I to Not I insert, 5´ to 3´ respectively. 

Poly(A)+ tailed constructs (dap, thr, trp, phe, lys)

These clones can be cut with different restriction enzymes to produce template DNA for 
either sense strand RNA synthesis or antisense RNA synthesis. The antisense control RNA 
for each B. subtilis gene is synthesized from linearized plasmid using T7 RNA polymerase 
with biotinylated nucleotides. The sense RNA for each B. subtilis gene is synthesized from 
linearized plasmid using T3 RNA polymerase with unlabeled nucleotides. For detailed 
preparation of sense RNA controls, please refer to Section 3, Chapter 2.

The antisense strand B. subtilis RNA controls are used as described above for bioB, bioC, 
and bioD genes. The sense strand RNA controls can be spiked into samples during mRNA 
preparation to monitor the efficiency of target preparation, hybridization, wash and stain.

Bacteria containing these recombinant plasmids can be obtained from the American Type 
Culture Collection (ATCC). See Reagents and Materials Required on page 2.2.5 for details.

T3 5’

Xho I Not I

AAAAA 3’ T7
2.2.7

http://www.affymetrix.com
http://www.atcc.org
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Eukaryotic Target Hybridization

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.3.5

Reagent Preparation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.3.6

Eukaryotic Target Hybridization  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.3.7

This Chapter Contains:

� Detailed steps for preparing the eukaryotic hybridization mix containing labeled target
and control cRNA.

� Instructions for hybridizing the target mix to a eukaryotic GeneChip® probe array.

After completing the procedures described in this chapter, the hybridized probe array is 
ready for washing, staining and scanning as detailed in Section 2, Chapter 4.
701027 rev 1 2.3.3
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Water, Molecular Biology Grade, BioWhittaker, P/N 16-001Y

� Acetylated Bovine Serum Albumin (BSA) solution (50 mg/mL), Invitrogen Life 
Technologies, P/N 15561-020

� Herring Sperm DNA, Promega Corporation, P/N D1811

� Micropure Separator, Millipore, P/N 42512 (optional)

� GeneChip® Eukaryotic Hybridization Control Kit, Affymetrix, P/N 900299
(contains Control cRNA and Control Oligo B2)

� Control Oligo B2, 3 nM, Affymetrix, P/N 900301 (can be ordered separately)

� 5 M NaCl, RNase-free, DNase-free, Ambion, P/N 9760G

� MES Free Acid Monohydrate SigmaUltra, Sigma-Aldrich, P/N M5287 

� MES Sodium Salt, Sigma-Aldrich, P/N M5057

� EDTA Disodium Salt, 0.5 M solution (100 mL), Sigma-Aldrich, P/N E7889

Miscellaneous Reagents
� Tough Spots, Label Dots, USA Scientific, P/N 9185 (optional)

� Surfact-Amps 20 (Tween-20), 10%, Pierce Chemical, P/N 28320

Miscellaneous Supplies

� GeneChip® Hybridization Oven 640, Affymetrix, P/N 800139

� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific,
P/N 1415-2600 (or equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman or equivalent

� Sterile-barrier pipette tips and non-barrier pipette tips
2.3.5

http://www.ambion.com
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http://www.sigma-aldrich.com
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Reagent Preparation

12X MES Stock

(1.22 M MES, 0.89 M [Na+])

For 1000 mL:

70.4 g MES free acid monohydrate

193.3 g MES Sodium Salt

800 mL of Molecular Biology Grade water

Mix and adjust volume to 1000 mL.

The pH should be between 6.5 and 6.7. Filter through a 0.2 µm filter.

2X Hybridization Buffer

(Final 1X concentration is 100 mM MES, 1 M [Na+], 20 mM EDTA, 0.01% Tween 20)

For 50 mL:

8.3 mL of 12X MES Stock

17.7 mL of 5 M NaCl

4.0 mL of 0.5 M EDTA 

0.1 mL of 10% Tween 20

19.9 mL of water

Store at 2-8°C, and shield from light

 Do not autoclave. Store at 2-8°C, and shield from light. Discard solution if yellow.
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Eukaryotic Target Hybridization

Please refer to the table below for the necessary amount of cRNA for appropriate probe 
array format. These recipes take into account that it is necessary to make extra hybridization 
cocktail due to a small loss of volume (10-20 µL) during each hybridization.

1. Mix the following for each target, scaling up volumes for hybridization to multiple 
probe arrays.

2. Equilibrate probe array to room temperature immediately before use.

3. Heat the hybridization cocktail to 99°C for 5 minutes in a heat block.

4. Meanwhile, wet the array by filling it through one of the septa (see Figure 3.4 for 
location of the probe array septa) with appropriate volume 1X Hybridization Buffer 
using a micropipettor and appropriate tips (Table 2.3.2).

Table 2.3.1

Hybridization Cocktail for Single Probe Array*

Component
Micro/Mini 

Array

Midi 

Array

Standard 

Array

Final 

Concentration 

Fragmented cRNA ** 5 µg 10 µg 15 µg 0.05 µg/µL

Control Oligonucleotide B2 
(3 nM)

1.7 µL 3.3 µL 5 µL 50 pM

20X Eukaryotic Hybridization 
Controls (bioB, bioC, bioD, cre)

5 µL 10 µL 15 µL 1.5, 5, 25 and 
100 pM respectively

Herring Sperm DNA
(10 mg/mL)

1 µL 2µL 3 µL 0.1 mg/mL

Acetylated BSA 
(50 mg/mL)

1 µL 2 µL 3 µL 0.5 mg/mL

2X Hybridization Buffer 50 µL 100 µL 150 µL 1X

H2O  to final volume 
of 100 µL

to final volume 
of 200 µL

 to final volume of 
300 µL

Final volume 100 µL 200 µL 300 µL

*Please refer to specific probe array package insert for information on array format.

**Please see Section 2, Chapter 1, page 2.1.21 for amount of adjusted fragmented cRNA to use when starting 
from total RNA.

It is imperative that frozen stocks of 20X GeneChip® Eukaryotic Hybridization Control 
cocktail be heated to 65°C for 5 minutes to completely resuspend the cRNA before 
aliquotting.

It is important to allow the arrays to normalize to room temperature completely. 
Specifically, if the rubber septa are not equilibrated to room temperature, they may 
be prone to cracking which can lead to leaks.

It is necessary to use two pipette tips when filling the probe array cartridge: one for 
filling and the second to allow venting of air from the hybridization chamber. After 
the addition of hybridization cocktails to the array, the septa may be covered with 
Tough Spots to prevent evaporation.
2.3.7
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5. Incubate the probe array filled with 1X Hybridization Buffer at 45°C for 10 minutes 
with rotation.

6. Transfer the hybridization cocktail that has been heated at 99°C, in step 3, to a 45°C 
heat block for 5 minutes.

7. Spin hybridization cocktail(s) at maximum speed in a microcentrifuge for 5 minutes to 
remove any insoluble material from the hybridization mixture.

8. Remove the buffer solution from the probe array cartridge and fill with appropriate 
volume (Table 2.3.2 on page 2.3.8) of the clarified hybridization cocktail avoiding any 
insoluble matter in the volume at the bottom of the tube.

9. Place probe array in rotisserie box in 45°C oven.

Avoid stress to rotisserie motor; load probe arrays in a balanced configuration around 
rotisserie axis. Rotate at 60 rpm.

10. Hybridize for 16 hours.

During the latter part of the 16-hour hybridization, proceed to Section 2, Chapter 4 to 
prepare reagents required immediately after completion of hybridization.

Table 2.3.2

Probe Array Cartridge Volumes

Array Hybridization Volume Total Fill Volume

Standard 200 µL 250 µL

Midi 130 µL 160 µL

Mini 80 µL 100 µL

Micro 80 µL 100 µL

Figure 3.4    

GeneChip® Probe Array
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Eukaryotic Arrays: 
Washing, Staining and Scanning

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.4.5

Reagent Preparation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.4.6

Experiment and Fluidics Station Setup  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.4.7

Step 1: Defining File Locations .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.4.7

Step 2: Entering Experiment Information.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.4.7

Step 3: Preparing the Fluidics Station.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.4.8

Probe Array Wash and Stain   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2.4.9

Washing and Staining Procedure 1: Single Stain for Eukaryotic Targets   .  .  .  .  .  . 2.4.9

Washing and Staining Procedure 2: Antibody Amplification for 
Eukaryotic Targets   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.4.12

Probe Array Scan  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.4.15

Shutting Down the Fluidics Station .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.4.16

Customizing the Protocol  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  2.4.17

This Chapter Contains:

� Instructions for using the GeneChip® Fluidics Station to automate the washing and 
staining of eukaryotic GeneChip® expression probe arrays.

� Instructions for scanning probe arrays using the GeneArray® scanner.

After completing the procedures described in this chapter, the scanned probe array image 
(.dat file) is ready for analysis, as explained in Section 4.
701028 rev 1 2.4.3
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Water, Molecular Biology Grade, BioWhittaker, P/N 16-001Y

� Distilled water, Invitrogen Life Technologies, P/N 15230-147

� Acetylated Bovine Serum Albumin (BSA) solution (50 mg/mL), Invitrogen Life 
Technologies, P/N 15561-020

� R-Phycoerythrin Streptavidin, Molecular Probes, P/N S-866

� 5 M NaCl, RNase-free, DNase-free, Ambion, P/N 9760G

� PBS, pH 7.2, Invitrogen Life Technologies, P/N 20012-027

� 20X SSPE (3 M NaCl, 0.2 M NaH2PO4, 0.02 M EDTA), BioWhittaker, P/N 16-010Y

� Goat IgG, Reagent Grade, Sigma-Aldrich, P/N I 5256

� Anti-streptavidin antibody (goat), biotinylated, Vector Laboratories, P/N BA-0500

� 10% surfact-Amps20 (Tween-20), Pierce Chemical, P/N 28320

� Bleach (5.25% Sodium Hypochlorite), VWR Scientific, P/N 21899-504 (or equivalent)

Miscellaneous Supplies
� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific, P/N 1415-2600 

(or equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman (or equivalent)

� Sterile-barrier pipette tips and non-barrier pipette tips

� Tygon Tubing, 0.04″ inner diameter, Cole-Palmer, P/N H-06418-04
2.4.5
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Reagent Preparation

Stringent Wash Buffer

(100 mM MES, 0.1 M [Na+], 0.01% Tween 20)

For 1000 mL:

83.3 mL of 12X MES Stock Buffer (see Section 2, Chapter 3 for reagent preparation)

5.2 mL of 5 M NaCl

1.0 mL of 10% Tween 20

910.5 mL of water 

Filter through a 0.2 µm filter

Store at 2-8°C and shield from light

Non-Stringent Wash Buffer

(6X SSPE, 0.01% Tween 20)

For 1000 mL:

300 mL of 20X SSPE

1.0 mL of 10% Tween-20

698 mL of water

Filter through a 0.2 µm filter

2X Stain Buffer

(Final 1X concentration: 100 mM MES, 1 M [Na+], 0.05% Tween 20)

For 250 mL:

41.7 mL 12X MES Stock Buffer (see Section 2, Chapter 3 for reagent preparation)

92.5 mL 5 M NaCl

2.5 mL 10% Tween 20

112.8 mL water

Filter through a 0.2 µm filter

Store at 2-8°C and shield from light

10 mg/mL Goat IgG Stock

Resuspend 50 mg in 5 mL PBS

Store at 4°C
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Experiment and Fluidics Station Setup

Step 1:  Defining File Locations

Before working with Microarray Suite it is important to define where the program stores 
and looks for files.

1. Launch Microarray Suite from the workstation and select Tools → Defaults → File 
Locations from the menu bar.

2. The File Locations window displays the locations of the following files:

� Probe Information (library files, mask files)

� Fluidics Protocols (fluidics station scripts)

� Experiment Data (.exp, .dat, .cel and .chp files are all saved to location selected here)

3. Verify that all three file locations are set correctly and click OK.

Contact Affymetrix Technical Support if you have any questions regarding this 
procedure.

Step 2:  Entering Experiment Information

To wash, stain and scan a probe array, an experiment must first be defined in the Microarray 
Suite.

1. Select Run → Experiment Info from the menu bar. Alternatively, click the New 
Experiment icon on the tool bar.

⇒ The Experiment Information dialog box appears allowing the experiment name to 
be defined along with several other parameters such as probe array type, sample 
description and comments.

2. Type in the Experiment Name. 

3. In the Probe Array Type box, click the arrow and select the probe array type from the 
drop-down list.

Experiment name and probe array type are required. Complete as much of the other 
information as desired. The protocol information at the bottom of the dialog box is 
exported to the experiment information dialog box after the hybridization and scan are 
completed.

4. Save the experiment by selecting Save.

The name of the experiment is used by Microarray Suite to access the probe array type 
and data for the sample while it is being processed. Data files generated for the sample 
are automatically labeled to correspond to the experiment name. Microarray Suite 
automatically fills in the Protocol section of this dialog box with information on array 
processing from the fluidics station.

5. Close the Experiment Information dialog box.
2.4.7
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Step 3:  Preparing the Fluidics Station

The GeneChip® Fluidics Station 400 is used to wash and stain the probe arrays. It is 
operated using Microarray Suite.

Setting Up the Fluidics Station

1. Turn on the Fluidics Station using the toggle switch on the lower left side of the 
machine.

2. Select Run → Fluidics from the menu bar. 

⇒ The Fluidics Station dialog box appears with a drop-down list for selecting the 
experiment name for each of the fluidics station modules. A second drop-down list 
is accessed for choosing the Protocol for each of the four fluidics station modules.

Priming the Fluidics Station

Priming ensures that the lines of the fluidics station are filled with the appropriate buffers 
and the fluidics station is ready for running fluidics station protocols.

Priming should be done:

� When the fluidics station is first started.

� When wash solutions are changed.

� Before washing, if a shutdown has been performed.

� If the LCD window instructs the user to prime.

1. To prime the fluidics station, select Protocol in the Fluidics Station dialog box.

2. Choose Prime for the respective modules in the Protocol drop-down list.

3. Change the intake buffer reservoir A to Non-stringent Wash Buffer and intake buffer 
reservoir B to Stringent Wash Buffer.

4. Click Run for each module to begin priming.

Refer to the GeneChip® Fluidics Station 400 User’s Guide for instructions on 
connecting and addressing multiple fluidics stations.
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Probe Array Wash and Stain

Affymetrix offers two staining protocols: 1) the single stain protocol for eukaryotic targets 
(page 2.4.9), and 2) a signal amplification protocol for eukaryotic targets (page 2.4.12). 
Please use the Antibody Amplification Washing and Staining Protocol for all arrays with 
probe cells of 24 µm or smaller.

1. After 16 hours of hybridization, remove the hybridization cocktail from the probe array 
and set it aside in a microcentrifuge tube. Store on ice during the procedure or at -80°C 
for long-term storage.

2. Fill the probe array completely with the appropriate volume of Non-Stringent Wash 
Buffer, as given in Table 2.3.2 on page 2.3.8.

Washing and Staining Procedure 1: Single Stain for Eukaryotic Targets

Preparing the SAPE Stain Solution

Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C, either foil-wrapped 
or kept in an amber tube. Remove SAPE from refrigerator and tap the tube to mix well 
before preparing stain solution. Do not freeze SAPE. Always prepare the SAPE stain 
solution immediately before use.

For each probe array to be stained, combine the following components in a microcentrifuge 
tube:

If necessary, at this point, the probe array can be stored at 4°C for up to 3 hours 
before proceeding with washing and staining. Equilibrate the probe array to room 
temperature before washing and staining.

Volumes needed will be the same for all fluidics protocols.  This procedure takes 
approximately 75 minutes to complete.

Table 2.4.1 

SAPE Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0 µL 1X

50 mg/mL acetylated BSA 24.0 µL 2 mg/mL

1 mg/mL Streptavidin-Phycoerythrin (SAPE) 6.0 µL 10 µg/mL

DI H20 270.0 µL —

Total 600 µL
2.4.9
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Washing and Staining the Probe Array

1. In the Fluidics Station dialog box on the workstation, select the correct experiment 
name in the drop-down Experiment list. The probe array type will appear 
automatically. 

2. In the Protocol drop-down list, select the specific single stain protocol to control the 
washing and staining of the probe array format being used: Table 2.4.2.

3. Choose Run in the Fluidics Station dialog box to begin the washing and staining. 
Follow the instructions on the LCD window on the fluidics station.

If you are unfamiliar with inserting and removing probe arrays from the fluidics station 
modules, please refer to the GeneChip® Fluidics Station 400 User’s Guide.

4. Insert the appropriate probe array into the designated module of the fluidics station 
while the probe array lever is in the EJECT position. When finished, verify that the 
probe array lever is returned to the ENGAGE position.

5. Remove any microcentrifuge tube remaining in the sample holder of the fluidics station 
module(s) being used.

6. Place the microcentrifuge tube containing the SAPE stain solution into the sample 
holder, verifying that the metal sampling needle is in the tube with its tip near the 
bottom.

⇒ The Fluidics Station dialog box and the LCD window display the status of the 
washing and staining as they progress. When the wash is complete, the LCD 
window displays the message EJECT CARTRIDGE.

7. Remove microcentrifuge tube containing stain and replace with an empty 
microcentrifuge tube.

8. Remove the probe arrays from the fluidics station modules by first moving the probe 
array holder lever to the EJECT position. When finished, verify that the probe array 
holder is returned to the ENGAGE position.

Table 2.4.2 

Fluidics Protocols - Single Stain for Eukaryotic Targets

Standard Format

EukGE-WS1
Mini Format

Mini_euk1

Post Hyb 
Wash #1

10 cycles of 2 mixes/cycle with 
Wash Buffer A at 25°C

 10 cycles of 2 mixes/cycle with 
Wash Buffer A at 25°C

Post Hyb 
Wash #2

4 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

8 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

Stain Stain the probe array for 30 minutes in 
SAPE solution at 25°C

Stain the probe array for 10 minutes in 
SAPE solution at 25°C

Final Wash
10 cycles of 4 mixes/cycle with 
Wash Buffer A at 25°C. The holding 
temperature is 25°C

10 cycles of 4 mixes/cycle with 
Wash Buffer A at 30°C. The holding 
temperature is 25°C

• Wash Buffer A = non-stringent wash buffer
• Wash Buffer B = stringent wash buffer
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9. Check the probe array window for large bubbles or air pockets. If bubbles are present, 
proceed to Table 2.4.3.

If the probe array has no large bubbles, it is ready to scan on the GeneArray® Scanner. 
Proceed to Probe Array Scan on page 2.4.15. If there are no more samples to hybridize, 
shut down the fluidics station following the procedure outlined in this chapter, Shutting 
Down the Fluidics Station on page 2.4.16.

Keep the probe arrays at 4°C and in the dark until ready for scanning.

10. ENGAGE wash block. Proceed to Probe Array Scan on page 2.4.15.

For proper cleaning and maintenance of the fluidics station including the bleach 
protocol,  refer to Section 5, Fluidics Station Maintenance Procedures.

Table 2.4.3

If Bubbles are Present

Return the probe array to the probe array holder. Latch the probe array holder by gently 
pushing it up until a light click is heard. Engage the washblock by firmly pushing up on the 
probe array lever to the ENGAGE position.
The fluidics station will drain the probe array and then fill it with a fresh volume of the last 
wash buffer used. When it is finished, if the LCD window displays EJECT CARTRIDGE 
again, remove the probe array and inspect it again for bubbles. If no bubbles are present, it is 
ready to scan. Proceed to Probe Array Scan on page 2.4.15.
If several attempts to fill the probe array without bubbles are unsuccessful, the array should 
be filled with Wash A (non-stringent buffer) manually. Excessive washing will result in a 
loss of signal intensity. Contact Affymetrix Technical Support for details on the procedure. 
Remove the probe array and run the CLEAN procedure on the particular module before 
starting a new hybridization. 
2.4.11
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2.4.12
Washing and Staining Procedure 2: Antibody Amplification for Eukaryotic Targets

This protocol is recommended for use with probe arrays with probe cells of 24 µm or 
smaller. This procedure takes approximately 75 minutes to complete.

Preparing the Staining Reagents

Prepare the following reagents. Volumes given are sufficient for one probe array.

SAPE Stain Solution

Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C, either foil-wrapped 
or kept in an amber tube. Remove SAPE from refrigerator and tap the tube to mix well 
before preparing stain solution. Do not freeze concentrated SAPE or diluted SAPE stain 
solution. Always prepare the SAPE stain solution immediately before use.

Mix well and divide into two aliquots of 600 µL each to be used for stains 1 and 3 
respectively.

Antibody Solution

Table 2.4.4 

SAPE Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 600.0 µL 1X

50 mg/mL acetylated BSA 48.0 µL 2 mg/mL

1 mg/mL Streptavidin-Phycoerythrin (SAPE) 12.0 µL 10 µg/mL

DI H20 540.0 µL —

Total 1200 µL

Table 2.4.5 

Antibody Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0 µL 1X

50 mg/mL acetylated BSA 24.0 µL 2 mg/mL

10 mg/mL Normal Goat IgG 6.0 µL 0.1 mg/mL

0.5 mg/mL biotinylated antibody 3.6 µL 3 µg/mL

DI H20 266.4 µL —

Total 600 µL
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Washing and Staining the Probe Array

1. In the Fluidics Station dialog box on the workstation, select the correct experiment 
name from the drop-down Experiment list. 

⇒ The Probe Array Type appears automatically.

2. In the Protocol drop-down list, select the appropriate antibody amplification protocol 
to control the washing and staining of the probe array format being used.

3. Choose Run in the Fluidics Station dialog box to begin the washing and staining. 
Follow the instructions in the LCD window on the fluidics station.

If you are unfamiliar with inserting and removing probe arrays from the fluidics station 
modules, please refer to the GeneChip® Fluidics Station 400 User’s Guide.

4. Insert the appropriate probe array into the designated module of the fluidics station 
while the probe array lever is in the EJECT position. When finished, verify that the 
probe array lever is returned to the ENGAGE position.

5. Remove any microcentrifuge tube remaining in the sample holder of the fluidics station 
module(s) being used.

6. Place a microcentrifuge tube containing 600 µL SAPE solution into the sample holder, 
making sure that the metal sampling needle is in the tube with its tip near the bottom.

⇒ The Fluidics Station dialog box and the LCD window display the status of the 
washing and staining as they progress.

Table 2.4.6 

Fluidics Protocols -Antibody Amplification for Eukaryotic Targets

Standard Format

EukGE-WS2
Midi Format

Midi_euk2
Micro / Mini Format

Micro_1v1 / Mini_euk2

Post Hyb 
Wash #1

10 cycles of 2 mixes/cycle with 
Wash Buffer A at 25°C

10 cycles of 2 mixes/cycle with 
Wash Buffer A at 30°C

 10 cycles of 2 mixes/cycle with 
Wash Buffer A at 25°C

Post Hyb 
Wash #2

4 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

6 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

8 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C

Stain Stain the probe array for 10 minutes 
in SAPE solution at 25°C

Stain the probe array for 5 minutes 
in SAPE solution at 35°C

Stain the probe array for 10 minutes 
in SAPE solution at 25°C

Post Stain 
Wash

10 cycles of 4 mixes/cycle with 
Wash Buffer A at 25°C

10 cycles of 4 mixes/cycle with 
Wash Buffer A at 30°C

10 cycles of 4 mixes/cycle with 
Wash Buffer A at 30°C

2nd Stain Stain the probe array for 10 minutes 
in antibody solution at 25°C

Stain the probe array for 5 minutes 
in antibody solution at 35°C

Stain the probe array for 10 minutes 
in antibody solution at 25°C

3rd Stain Stain the probe array for 10 minutes 
in SAPE solution at 25°C

Stain the probe array for 5 minutes 
in SAPE solution at 35°C

Stain the probe array for 10 minutes 
in SAPE solution at 25°C

Final Wash
15 cycles of 4 mixes/cycle with 
Wash Buffer A at 30°C. 
The holding temperature is 25°C

15 cycles of 4 mixes/cycle with 
Wash Buffer A at 35°C. 
The holding temperature is 25°C

15 cycles of 4 mixes/cycle with 
Wash Buffer A at 35°C. 
The holding temperature is 25°C

• Wash Buffer A = non-stringent wash buffer
• Wash Buffer B = stringent wash buffer

Three-stain protocols require the user to replace stain solutions as directed by the 
LCD window during staining steps.
2.4.13
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2.4.14
7. When the LCD window indicates, replace the microcentrifuge tube containing the 
SAPE stain with a microcentrifuge tube containing 600 µL antibody stain solution into 
the sample holder, making sure that the metal sampling needle is in the tube with its tip 
near the bottom.

8. When the LCD window indicates, replace the microcentrifuge tube containing 
antibody solution with the microcentrifuge tube containing the second 600 µL SAPE 
solution.

⇒ When the protocol is complete, the LCD window displays the message  EJECT 
CARTRIDGE.

9. Remove microcentrifuge tube containing stain and replace with an empty 
microcentrifuge tube.

10. Remove the probe arrays from the fluidics station modules by first moving the probe 
array holder lever to the EJECT position. When finished, verify that the probe array 
holder is returned to the ENGAGE position.

11. Check the probe array window for large bubbles or air pockets. If bubbles are present, 
proceed to Table 2.4.7.

If the probe array has no large bubbles, it is ready to scan on the GeneArray® Scanner. 
Proceed to Probe Array Scan on page 2.4.15. If there are no more samples to hybridize, 
shut down the fluidics station following the procedure in Shutting Down the Fluidics 
Station on page 2.4.16.

Keep the probe arrays at 4°C and in the dark until ready for scanning.

12. ENGAGE wash block. Proceed to Probe Array Scan on page 2.4.15

For proper cleaning and maintenance of the fluidics station, including the bleach 
protocol, refer to Section 5, Fluidics Station Maintenance Procedures.

Table 2.4.7

If Bubbles are Present

Return the probe array to the probe array holder. Latch the probe array holder by gently 
pushing it up until a light click is heard. Engage the washblock by firmly pushing up on the 
probe array lever to the ENGAGE position.
The fluidics station will drain the probe array and then fill it with a fresh volume of the last 
wash buffer used. When it is finished, if the LCD window displays EJECT CARTRIDGE 
again, remove the probe array and inspect it again for bubbles. If no bubbles are present, it is 
ready to scan. Proceed to Probe Array Scan on page 2.4.15.
If several attempts to fill the probe array without bubbles are unsuccessful, the array should 
be filled with Wash A (non-stringent buffer) manually. Excessive washing will result in a 
loss of signal intensity. Contact Affymetrix Technical Support for details on the procedure. 
Remove the probe array and run the CLEAN procedure on the particular module before 
starting a new hybridization. 
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Probe Array Scan

The scanner is also controlled by Affymetrix® Microarray Suite. The probe array is scanned 
after the wash protocols are complete. Make sure laser is warmed up prior to scanning by 
turning the laser on at least 15 minutes before use. If probe array was stored at 4°C, warm to 
room temperature before scanning. Refer to the Microarray Suite online help and the 
appropriate scanner user’s manual for more information on scanning.

If necessary, clean the glass surface of probe array with a non-abrasive towel or tissue 
before scanning. Do not use alcohol to clean glass.

1. Click Run → Scanner from the  menu bar. Alternatively, click the Start Scan icon in 
the tool bar.

⇒ The Scanner dialog box appears with a drop-down list of experiments that have not 
been run. A scrollable window is also displayed showing previous scans. 

2. Select the experiment name that corresponds to the probe array to be scanned. A 
previously run experiment can also be selected from the Previous Experiments list by 
double-clicking the desired name.

3. To perform the recommended 2X Image scan, a [2] must be entered into the box for 
Number of Scans.

4. Click the Options button in the Scanner dialog box to check for the correct pixel value 
and wavelength of the laser beam.

For Probe Arrays with Probe Cells 24 µm or Less
� Pixel value = 3 µm

� Wavelength = 570 nm

For a 50 µm Probe Array with a Phycoerythrin Stain
� Pixel value = 6 µm

� Wavelength = 570 nm

5. Once the experiment has been selected, click the Start button.

⇒ A dialog box prompts you to load a sample into the scanner.

6. Open the sample door on the scanner and insert the probe array into the holder. Do not 
force the probe array into the holder. Close the sample door of the scanner.

7. Click OK in the Start Scanner dialog box.

⇒ The scanner begins scanning the probe array and acquiring data. When Scan in 
Progress is selected from the View menu, the probe array image appears on the 
screen as the scan progresses.

The scanner uses an argon-ion laser and is equipped with a safety interlock system. 
Defeating the interlock system may result in exposure to hazardous laser light.
2.4.15
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2.4.16
Shutting Down the Fluidics Station

1. After removing a probe array from the probe array holder, the LCD window displays 
the message ENGAGE WASHBLOCK. 

2. Engage the washblock by firmly pushing up on the probe array lever to the ENGAGE 
position.

⇒ The fluidics station automatically performs a Cleanout procedure. The LCD 
window indicates the progress of the Cleanout procedure.

3. When the fluidics station LCD window indicates REMOVE VIAL, the Cleanout 
procedure is complete.

4. Remove the sample microcentrifuge tube from the sample holder.

5. If no other hybridizations are to be performed, place wash lines into a bottle filled with 
deionized water.

6. Choose Shutdown for all modules from the drop-down Protocol list in the Fluidics 
Station dialog box. Click the Run button for all modules.

The Shutdown protocol is critical to instrument reliability. Refer to the Affymetrix 
GeneChip® Fluidics Station 400 User’s Guide for more information. 

7. After Shutdown protocol is complete, flip the ON/OFF switch of the fluidics station to 
the OFF position.

To maintain the cleanliness of the fluidics station and obtain the highest quality 
image and data possible, a weekly bleach protocol and a monthly decontamination 
protocol are highly recommended.  Please refer to Section 5, Fluidics Station 
Maintenance Procedures for further detail.
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Customizing the Protocol

There may be times when the fluidics protocols need to be modified. Modification of 
protocols must be done before downloading the protocol to the fluidics station. Protocol 
changes will not affect runs in progress. For more specific instructions, refer to the 
Microarray Suite online help.

1. Select Tools → Edit Protocol from the menu bar.

⇒ The Edit Protocol dialog box appears.

2. Select the protocol to be changed from the Protocol Name drop-down list. 

⇒ The name of the protocol is displayed in the Protocol Name box. The conditions 
for that protocol are displayed on the right side of the Edit Protocol dialog box.

3. Select the item to be changed and input the new parameters as needed, keeping the 
parameters within the ranges shown below in Table 2.4.8.

4. To return to the default values for the protocol selected, click the Defaults button.

5. After all the protocol conditions are modified as desired, change the name of the edited 
protocol in the Protocol Name box.

6. Click Save, then close the dialog box.

Enter 0 (zero) for hybridization time if hybridization step is not required. Likewise, 
enter 0 (zero) for the stain time if staining is not required. Enter 0 (zero) for the number 
of wash cycles if a wash solution is not required.

Table 2.4.8

Valid Ranges for Wash/Stain Parameters

Parameter Valid Range

Wash Temperature for A1, B, A2 or A3 (°C) 15 to 50

Number of Wash Cycles for  A1, B, A2 or A3 0 to 99

Mixes / Wash cycle for  A1, B, A2 or A3 15 to 50

Stain Time (seconds) 0 to 86399

Stain Temperature (°C) 15 to 50

Holding Temperature (°C) 15 to 50

• Wash A1 corresponds to Post Hyb wash #1 in Tables 2.4.2 and 2.4.6.
• Wash B corresponds to Post Hyb wash #2 in Tables 2.4.2 and 2.4.6.
• Wash A2 corresponds to Post Stain Wash in Tables 2.4.2 and 2.4.6.
• Wash A3 corresponds to Final Wash in Tables 2.4.2 and 2.4.6.

If the protocol is saved without entering a new Protocol Name, the original protocol 
parameters will be overwritten.
2.4.17
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This Chapter Contains:

� Instructions for enriching, fragmenting and labeling RNA target from E. coli cells.

After completing the procedures described in this chapter, the labeled and fragmented target 
is hybridized to the GeneChip® E. coli Genome Array, as described in Section 3, Chapter 3.
701030 rev1 3.1.3
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3.1.4
Introduction

This chapter describes the assay procedures recommended for use with GeneChip® E. coli 
Genome Array. These procedures differ from the those described under the previous section 
primarily because unlike their eukaryotic counterpart, the majority of E. coli messenger 
RNAs do not contain poly(A)+ tails. To enrich for mRNA species, a procedure designed to 
remove 16S and 23S ribosomal RNAs, which constitute approximately 90% of the total 
RNA population, is utilized. The resulting RNA population is then directly labeled with 
biotin.

mRNA Enrichment Procedure

The enrichment procedure is a series of enzymatic steps that specifically eliminate the 16S 
and 23S rRNA species in the total E. coli RNA. Reverse transcriptase and primers specific 
to 16S and 23S rRNA are used to synthesize complementary DNAs. Then rRNA is 
removed enzymatically by treatment with RNase H, which specifically digests RNA within 
an RNA:DNA hybrid. The cDNA molecules are then removed by DNase I digestion and the 
enriched mRNA is purified on QIAGEN RNeasy columns.

RNA Fragmentation and Labeling Procedure

The direct labeling of RNA consists of the following steps:

1. The RNA is fragmented by heat and ion-mediated hydrolysis. 

2. The 5´-end RNA termini are enzymatically modified by T4 polynucleotide kinase with 
γ-S-ATP. 

3. Biotin is conjugated to 5´-ends of the RNA. After purification of the product, the 
efficiency of the labeling procedure can be assessed using a gel-shift assay described in 
Gel-Shift Assay on page 3.1.14.
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

Total RNA Isolation
� MasterPure™ RNA Purification Kit, Epicentre Technologies, P/N MCR85102

� Ready-Lyse™ Lysozyme Solution, Epicentre Technologies, P/N R1802M

� Isopropanol

� 75% Ethanol

mRNA Enrichment Procedure
� MMLV Reverse Transcriptase, New England BioLabs, P/N M0253L

� 10X MMLV Reverse Transcriptase Buffer, New England BioLabs, P/N M0253L 
(contains DTT and is also supplied with MMLV Reverse Transcriptase)

� 16S rRNA Primers

� 23s rRNA Primers

� dATP, dCTP, dGTP, dTTP, Amersham Pharmacia Biotech, P/N 27-2035-01

� SUPERase•In™, Ambion, P/N 2696

� Ribonuclease H (RNase H), E. coli, Epicentre Technologies, P/N R0601K

� Deoxyribonuclease I (DNase I), Amersham Pharmacia Biotech, P/N 27-0514-01

� 0.5 M EDTA, pH 8.0, Invitrogen Life Technologies, P/N 15575-038

� RNeasy Mini Kit, QIAGEN, P/N 74104

� β-Mercaptoethanol

� 96 to 100% Ethanol

� Nuclease-free Water, Ambion, P/N 9930

Name Sequence

16S1514 5´-CCTAC GGTTA CCTTG TT-3´
16S889 5´TTAAC CTTGC GGCCG TACTC-3´
16S541 5´-TCCGA TTAAC GCTTG CACCC-3´

Name Sequence

23S2878 5´-CCTCA CGGTT CATTA GT-3´
23SEco2064 5´-CTATA GTAAA GGTTC ACGGG-3´
23SEco1595 5´-CCTGT GTCGG TTTGG GGT-3´
23S1022 5´-TCCCA CATCG TTTCC CAC-3´
23S539 5´-CCATT ATACA AAAGG TAC-3’

All primers should be purchased in the 1 µmole amount and purified by HPLC. 
Oligonucleotides purchased from Operon have been used successfully in the 
procedure described in this chapter.
3.1.5

http://www.ambion.com
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3.1.6
RNA Fragmentation and Labeling Reaction
� T4 Polynucleotide Kinase and 10X NEBuffer, New England BioLabs, P/N 201L

� γ-S-ATP (20 µmoles), Roche Molecular Biochemical, P/N 1162306

� MOPS, Sigma-Aldrich, P/N M3183

� PEO-Iodoacetyl-Biotin (50 mg), Pierce Chemical, P/N 21334ZZ

� 3 M Sodium Acetate (NaOAc), pH 5.2, Sigma-Aldrich, P/N S 7899

� 96 to 100% Ethanol

� RNA/DNA Mini Column Kit, QIAGEN, P/N 14123

� β-Mercaptoethanol

� Isopropanol

� 70% Ethanol

� Glycogen (20 mg/mL), Roche Molecular Biochemical, P/N 901393

Gel-Shift Assay
� Novex XCell SureLock™ Mini-Cell, Invitrogen, P/N EI9001

� 4-20% TBE Gel, 1.0 mm, 12 well, Invitrogen, P/N EC62252

� Sucrose Gel Loading Dye, 5X, Amresco, P/N E-274

� 10X TBE Running Buffer

� SYBR Gold, Molecular Probes, P/N S-11494

� 10 bp and 100 bp DNA ladder, Invitrogen Life Technologies, P/N 10821-015 and 
15628-019, respectively

� ImmunoPure NeutrAvidin, Pierce Chemical, P/N 31000ZZ

� 1M Tris pH 7.0, Ambion, P/N 9850G

Miscellaneous Supplies

� GeneChip® Hybridization Oven 640, Affymetrix, P/N 800139

� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific, P/N 1415-2600 
(or equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman or equivalent

� Sterile-barrier pipette tips and non-barrier pipette tips

� Thermocycler

� Refrigerated microcentrifuge

� Spectrophotometer and quartz micro cuvettes

� Gel imaging system with appropriate filter for SYBR Green I or Gold. 

� PCR tubes

� 0.2 µm filters for liquid sterilization

� Tough Spots, Label Dots, USA Scientific, P/N 9902 (optional)

http://www.ambion.com
http://www.amresco-inc.com
http://www.invitrogen.com
http://www.invitrogen.com
http://www.probes.com
http://www.neb.com
http://www.piercenet.com/
http://www.piercenet.com/
http://www.qiagen.com
http://www.rainin.com
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.usascientific.com
http://www.usascientific.com
http://www.affymetrix.com
http://www.invitrogen.com/
http://biochem.roche.com/
http://biochem.roche.com/


CHAPTER 1   Direct Labeling of Enriched E. coli mRNA

E
. 

c
o

li
Reagent Preparation

mRNA Enrichment Procedure

rRNA Removal Primer Stock

Individual primers are maintained at a stock concentration of 100 µM. Each primer is 
diluted 10-fold in the final primer mix to a concentration of 10 µM. Individual stocks 
and the primer mix are stored at -20°C.

25 mM dNTP Mix

Add 50 µL of each dNTP stock solution (100 mM each) to a sterile microcentrifuge tube. 
Mix thoroughly. Store at -20°C.

RNA Fragmentation and Labeling Reaction

500 mM MOPS, pH 7.5

For 100 mL:

10.5 g MOPS

80 mL Distilled water

Mix and adjust pH to 7.5 with 1 M NaOH. Add Distilled water to 100 mL. 
Filter through 0.2 µM filter. Store at room temperature.

Gel-shift Assay

2 mg/mL NeutrAvidin

Resuspend 10 mg NeutrAvidin in 5 mL solution containing 50 mM Tris-Cl, pH 7.6, 
200 mM NaCl. Store at 4°C.
3.1.7
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Total RNA Isolation

Prior to the enrichment process, total RNA is isolated. For E. coli, Affymetrix has 
successfully used the Epicentre MasterPure RNA Purification Kit. Typical yields from a 
10 mL log-phase culture range from 80-400 µg of total RNA. After purification, the RNA 
concentration is determined by absorbance at 260 nm on a spectrophotometer (1 absorbance 
unit = 40 µg/mL RNA). The A260/A280 ratio should be approximately 2.0, with ranges 
between 1.8 to 2.1 considered acceptable. We recommend checking the quality of the RNA 
by running it on an agarose gel prior to starting the assay. The figure below shows 1 µg 
samples from three acceptable RNA preparations. The 23S and 16S rRNA bands should be 
clear without any obvious smearing patterns.

Figure 3.1.1    

Typical RNA preparations from E. coli

Lane 1 - 1 µg Sample 1
Lane 2 - 1 µg Sample 2
Lane 3 - 1 µg Sample 3
Lane 4 - RNA Size Markers
3.1.9
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3.1.10
mRNA Enrichment Procedure

The following protocol starts with 100 µg of total RNA.  Incubations are performed in a 
thermocycler. Each sample is equally split between four 200-µL PCR tubes. It takes 
approximately 5 hours to obtain enriched mRNA.

Step 1: cDNA Synthesis

1. Prepare the following mixture in each of the four PCR tubes.

2. Heat RNA and primer mixture to 70°C for 5 minutes and then cool to 4°C. 

3. Add the following components to each of the four tubes.

The enrichment procedure involves three enzymatic steps, and the amount of 
enzymes used and incubation time are critical to the success of the assay. Please 
exercise precautions and follow standard laboratory procedures when handling RNA 
samples.

Optionally, 1 µL of control transcript mix (lys, phe, dap, thr and trp from B. subtilis) 
can be added to total RNA prior to the enrichment procedure for a final concentration 
of 10 pM of each control transcript to be applied to the arrays. Please refer to 
Section 3, Chapter 2 for the detailed protocol to prepare control sense RNA.

The detection limit of the assay is estimated to be around 5 pM. Assuming complete 
recovery of spike transcripts, the final hybridization mix contains each transcript at 
10 pM concentration that is slightly above detection limit. Detection of these controls 
on the E. coli Genome Array serves as indicators of the labeling efficiency. 
Alternatively, various control transcripts can also be spiked in at variable 
concentrations to demonstrate the dynamic range of the assay.

Table 3.1.1

Primer Mixture for mRNA Enrichment

Components Volume or Amount Final Concentration

Total RNA 25.0 µg 0.83 µg/µL

10 µM rRNA Removal Primer Stock 7 µL 1.75 µM

500 pM Control Transcript (optional) 1 µL

Nuclease-free DI H2O Up to 40.0 µL —

Total Volume Added 40 µL

Table 3.1.2

Reverse Transcription Components

Components Volume Final Concentration

10X MMLV RT Buffer 10.0 µL 1X

25.0 mM dNTP Mix 2.0 µL 0.5 mM

20 U/µL SUPERase•In 3.0 µL 0.6 U/µL

200 U/µL MMLV RT 2.5 µL 5 U/µL

Nuclease-free H2O 42.5 µL —

Total Volume Added 60 µL
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4. Incubate the reaction at 42°C for 25 minutes, then at 45°C for 20 minutes.
Cool to 4°C.

5. Inactivate the enzyme at 65° for 5 minutes, then hold at 4°C. Proceed immediately to 
Step 2: rRNA Digestion, below.

step 2:  rRNA Digestion

1. Add the following to each of the four tubes.

2. Incubate the reaction at 37°C for 25 minutes, then hold at 4°C. Proceed immediately to 
Step 3: cDNA Digestion below.

step 3:  cDNA Digestion

1. Add the following to each of the four tubes.

2. Incubate the reaction at 37°C for 20 minutes. 

3. Inactivate the enzyme by adding 3 µL of 500 mM EDTA to each tube for a final 
concentration of 10.0 mM.

4. Pool reaction product from all four tubes and clean up the enriched mRNA with 
QIAGEN RNeasy Mini column.

5. Quantify the enriched mRNA preparation by 260 nm absorbance. Typical yields for the 
procedure are 20 to 40 µg of RNA (1.0 A260 unit = 40 µg/mL single strand RNA).

Table 3.1.3

RNase Digestion of rRNAs

Components Volume Final Concentration

10.0 U/µL RNase H 4.0 µL 0.4 U/µL

20 U/µL SUPERase•In 3.0 µL 0.6 U/µL

Total Volume Added 7 µL

Table 3.1.4

Digestion of cDNA

Components Volume Final Concentration

5.0 U/µL DNase I* 4.0 µL 0.2 U/µL

24.5 U/µL RNAguard 1.0 µL 0.225 U/µL

Total Volume Added 5 µL

*Dilute 10 U/µL DNase I to 5 U/µL with nuclease-free H2O.

The concentration of DNase I is critical. Excessive digestion may cause degradation 
of mRNA.  Lot-to-lot variation of enzyme activity may occur.  Therefore, titrate DNase 
concentrations when necessary.

The concentration and incubation time for DNase I are critical. Under-digestion is 
preferable to over-digestion.
3.1.11
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3.1.12
RNA Fragmentation and Labeling 
Reaction

As in the previous procedure, the fragmentation and labeling reactions are done in PCR 
tubes in a thermocycler. A maximum of 20 µg of RNA per tube is used in the fragmentation 
step. Incomplete fragmentation may occur if excess RNA is used. Split samples into 
multiple tubes if the yield of RNA from the enrichment step is greater than 20 µg. 
Following the 5´ thiolation and biotin addition reaction, the target is purified with ethanol 
precipitation or RNA/DNA Mini Columns. The reactions take about 6 hours to complete.

Step 1:  RNA Fragmentation

1. Prepare the following mixture.

2. Incubate the reaction at 95°C for 30 minutes.

3. Cool to 4°C.

Step 2:  RNA 5´-Thiolation

1. Prepare the following mixture.

The enriched mRNA is stored at -20°C until ready for use in the subsequent 
fragmentation and labeling reaction.

The reaction of PEO-Iodoacetyl-Biotin is highly pH-dependent.  MOPS is used as the 
buffer because of its inability to react with the iodoacetyl group under the reaction 
conditions. Other commonly used laboratory buffers containing amino groups such 
as Tris should not be used because of their reactivity with the iodoacetyl moiety.

Table 3.1.5

RNA Fragmentation Mix

Components Volume or Amount Final Concentration

10X NEBuffer for T4 Polynucleotide Kinase 10.0 µL 1.1X

enriched mRNA up to 20.0 µg —

DI H2O up to 88.0 µL total volume —

Final Volume 88 µL

Table 3.1.6

RNA Thiolation Mix

Components Volume Final Concentration

Fragmented RNA (from Step 1) 88.0 µL —

5 mM γ-S-ATP 2.0 µL 0.1 mM

10 U/µL T4 Polynucleotide Kinase 10.0 µL 1 U/µL

Final Volume 100.0 µL
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2. Incubate the reaction at 37°C for 50 minutes. 

3. Inactivate the reaction by heating at 65°C for 10 minutes and then cool to 4°C.

4. Remove excess γ-S-ATP by ethanol precipitation. If you have started with multiple 
tubes, combine all samples in one sterile microcentrifuge tube. Add 1/10 volume of 
3 M sodium acetate, pH 5.2, and 2.5 volumes of ethanol.  Leave on ice for 15 minutes.

5. Spin at 14,000 rpm at 4°C for 30 minutes to pellet the RNA. 

6. Resuspend the RNA pellet in 90 µL of DI H2O.

Step 3:  Biotin Addition

1. Prepare the following mixture.

2. Incubate the reaction at 37°C for one hour. 

3. Cool to 4°C.

4. Remove unincorporated biotin label using the QIAGEN RNA/DNA Mini Columns.

5. Dissolve the pelleted RNA in 20 to 30 µL of nuclease-free water.

6. Quantify product by 260 nm absorbance. Typical yields for the procedure are 2 to 4 µg 
of RNA. The labeled RNA should be stored at -20°C until ready for gel analysis or 
hybridization, as described in Section 3, Chapter 3.

Table 3.1.7

RNA Labeling Mix

Components Volume Final Concentration

500 mM MOPS, pH 7.5 6.0 µL 30 mM

Fragmented thiolated RNA (from Step 2) 90.0 µL —

50 mM PEO-Iodoacetyl-Biotin 4.0 µL 2 mM

Final Volume 100.0 µL

For increased RNA recovery, use one RNA/DNA column and 5.4 mL Buffer QRV2 for 
every 10.0 µg RNA. It is recommended to add 50 µg of glycogen as carrier during the 
precipitation step.  

Alternatively, clean up the labeling product by ethanol precipitation instead of 
Qiagen columns (add 50 µg of glycogen as carrier, 1/10 volume of 3 M sodium 
acetate and 2.5 volume of ethanol to samples), followed by twice washing the pellets 
with 750 µL of 70% ethanol.

The process may be stopped during ethanol precipitation following the RNA/DNA 
column purification.
3.1.13
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3.1.14
Gel-Shift Assay

After purification of the target, the efficiency of the labeling procedure can be assessed 
using the following procedure. This quality control protocol prevents hybridizing poorly 
labeled target onto the probe array. The addition of biotin residues is monitored in a gel-
shift assay where the fragments are incubated with avidin prior to electrophoresis. Biotin-
containing residues are retarded or shifted during the electrophoresis due to avidin binding. 
The nucleic acids are then detected by staining. Affymetrix routinely obtains approximately 
70% labeling efficiency as shown in the gel photograph (Figure 3.1.2). The procedure takes 
approximately 90 minutes to complete.

1. Prepare a NeutrAvidin solution of 2 mg/mL or higher. 50 mM Tris, pH 7.0 can be used 
to dilute the NeutrAvidin solution.

2. Place a 4-20% TBE gel into the gel holder and load system with 1X TBE Buffer.

3. For each sample to be tested, remove two 150 to 200 ng aliquots of fragmented and 
biotinylated sample to fresh tubes.

4. Add 5 µL of 2 mg/mL NeutrAvidin to each tube.

5. Mix and incubate at room temperature for 5 minutes.

6. Add loading dye to all samples to a final concentration of 1X loading dye.

7. Prepare 10 bp and 100 bp DNA ladders (1µL ladder + 7 µL water + 2 µL loading dye 
for each lane).

8. Carefully load samples and two ladders on gel. (Each gel well can hold a maximum of 
20 µL.)

The absence of a shift pattern indicates poor biotin labeling. The problem should be 
addressed before proceeding to the hybridization step.

Figure 3.1.2    

Gel-shift assay for monitoring E. coli target labeling efficiency

Lane 1 - 10 bp DNA Ladder
Lane 2 - Fragmented and labeled enriched E. coli RNA
Lane 3 - Fragmented and labeled enriched E. coli RNA 

with avidin
Lane 4 - Fragmented and labeled total E. coli RNA
Lane 5 - Fragmented and labeled total E. coli RNA with avidin
Lane 6 - 100 bp DNA Ladder
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9. Run the gel at 150 volts until the front dye (red) almost reaches the bottom. The 
electrophoresis takes approximately 1 hour.

10. While gel is running, prepare at least 100 mL of a 1X solution of SYBR Green II or 
Gold for staining.

11. After the gel is complete, break open cartridge and stain the gel in 1X SYBR Green II 
or Gold for 10 minutes.

12. Place the gel on the UV light box and produce an image following standard procedure. 
Be sure to use the appropriate filter for SYBR Green II or Gold.

SYBR Green II and Gold are light sensitive. Therefore use caution and shield the 
staining solution from light.  Prepare a new batch of stain at least once a week.
3.1.15
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Preparation of Control Spike Transcripts for 
GeneChip® E. coli Genome Array

Overview   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.4

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.5

Bacterial Plasmid DNA Preparation   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.6

Linearization of Plasmid DNA Preparation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.7

Purification of Linearized Plasmid DNA  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.7

In Vitro Transcription (IVT) to Produce Control Sense Transcripts .  .  .  .  .  .  .  .  .  . 3.2.8

Preparing the Control Transcript Mix .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.2.8

This Chapter Contains:

� Detailed steps for producing full-length control spike sense RNA.

After completing the procedures described in this chapter, the control sense transcripts can 
be added to purified E. coli RNA samples prior to enrichment and labeling procedure as 
described in Section 3, Chapter 1.
701031 rev 1 3.2.3
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3.2.4
Overview

This chapter describes protocols used to generate sense RNA controls from B. subtilis 
genes.  These control transcripts can be spiked into E. coli total RNA used for target 
preparation at a predetermined concentration to monitor labeling, hybridization and staining 
efficiency.

To be used as control for assay performance, the GeneChip® E. coli Genome Array contains 
probe sets with sequences of dap, thr, phe, lys and trp genes from B. subtilis. These genes 
have been cloned into Stratagene pBluescript as an Xho I to Not I insert, 5´ to 3´, 
respectively (see Section 2, Chapter 2, Preparation of Controls for Eukaryotic Arrays).

pGIBS-lys ATCC 87482

pGIBS-phe ATCC 87483

pGIBS-thr ATCC 87484

pGIBS-trp ATCC 87485

pGIBS-dap ATCC 87486

These clones can be digested with the Not I restriction enzyme to produce linear template 
DNA for the subsequent in vitro transcription (IVT) to produce sense strand RNA by T3 
RNA polymerase as control molecules. 

Bacteria containing these recombinant plasmids can be obtained from the American Type 
Culture Collection (ATCC). 

T3 5’

Xho I Not I

3’ T7

http://www.atcc.org
http://www.atcc.org
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Expression Control Clones, American Type Culture Collection (ATCC)

� pGIBS-lys ATCC 87482

� pGIBS-phe ATCC 87483

� pGIBS-thr ATCC 87484

� pGIBS-trp ATCC 87485

� pGIBS-dap ATCC 87486

� Not I restriction Endonuclease, New England BioLabs, P/N R0189S

� Phase Lock Gel, Eppendorf - 5 Prime, Inc., P/N pl-188233

� Phenol/chloroform/isoamyl alcohol, Ambion, P/N 9732

� MEGAscript T3 Kit, Ambion, P/N 1338

Miscellaneous Reagents
� 3 M NaAcetate (NaOAc)

� Absolute Ethanol

� 80% Ethanol

� RNeasy Mini Kit, QIAGEN, P/N 74104
3.2.5
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3.2.6
Bacterial Plasmid DNA Preparation

1. Grow E. coli bacterial cultures containing recombinant plasmids according to 
established protocols (a minimum 50 mL of culture volume is recommended).

2. Prepare plasmid DNA from overnight cultures using standard procedures or 
commercial kits.

Affymetrix has obtained reliable results using QIAGEN Plasmid Kits for plasmid DNA 
isolation.
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Linearization of Plasmid DNA 
Preparation

1. In a 50 µL reaction volume, digest 10 µg of plasmid with the restriction enzyme, NotI, 
according to the enzyme manufacturer's recommendations.

2. Analyze 50 ng of the uncut and linearized plasmid by gel electrophoresis on a 
1% agarose gel. Complete digestion of the plasmid is required for IVT. Repeat 
restriction enzyme digestion, if necessary.

Purification of Linearized Plasmid 
DNA

Purify the linearized plasmid from restriction enzymes and potential RNase contaminants 
before proceeding to IVT using a Phase Lock Gel-phenol/chloroform extraction procedure.

Phase Lock Gels (PLG) form an inert, sealed barrier between the aqueous and organic 
phases of phenol-chloroform extractions. The solid barrier allows more complete recovery 
of the sample (aqueous phase) and minimizes interface contamination of the sample. PLG’s 
are sold as premeasured aliquots in 1.5 mL tubes to which sample and phenol chloroform 
are directly added.

1. Pellet the Phase Lock Gel (1.5 mL tube with PLG I-heavy) in a microcentrifuge at 
≥ 12,000 x g for 20 seconds.

2. Dilute the linearized plasmid to final volume of 150 µL with TE and add equal volume 
of (25:24:1) Phenol:chlorororm:isoamyl alcohol (saturated with 10 mM Tris-HCl 
pH8.0/1 mM EDTA). Vortex.

3. Transfer the mix to the PLG tube and microcentrifuge at ≥ 12,000 x g for 2 minutes.

4. Transfer the top aqueous phase to a new 1.5 mL tube.

5. Add 0.1 volumes (15 µL) of 3 M NaOAc and 2.5 volumes (375 µL) of absolute ethanol 
to the samples. Vortex.

6. Immediately centrifuge at ≥ 12,000 x g in a microcentrifuge at room temperature for 
20 minutes.

7. Carefully remove supernatent.

8. Wash pellet with 0.5 mL of 80% ethanol, then centrifuge at ≥ 12,000 x g at room 
temperature for 5 minutes.

9. Remove the supernatent very carefully and air dry the pellet.

10. Resuspend DNA pellet in 15 µL of RNase-free water.

11. Quantify the DNA by absorbance at 260 nm (50 µg/mL of DNA for 1 absorbance unit 
at 260 nm).

The quality of DNA template can be monitored by the A260/A280 ratio, which should be 
between 1.8 and 2.0 for pure DNA.
3.2.7
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3.2.8
In Vitro Transcription (IVT) to Produce 
Control Sense Transcripts

Use MEGAscript T3 High Yield Transcription Kit for the IVT reaction.

1. To make up the reaction mix, follow the procedures in the instruction manual provided 
by Ambion.

2. Incubate the reaction for 4 hours at 37°C.

3. Clean up the reaction product with RNeasy Mini column.

4. Quantify the transcript by absorbance at 260 nm (40 µg/mL RNA = 1 absorbance unit 
at 260 nm).

Preparing the Control Transcript Mix

1. Prepare stock solutions for each of the five transcripts separately at 2.5 nM for each 
transcript.

Use the following table to calculate the amount of transcript needed to prepare 2.5 nM 
stock.

2. Mix equal volume of all five transcripts so that final concentration for each  is 500 pM.

3. Apply 4 µL of the transcript mix with each 100 µg of total RNA prior to the enrichment 
procedure as described in Chapter 1 of this section. Final concentration applied on the 
array for the control transcripts would be 10 pM, assuming 100% recovery.

No tracer is involved in this assay.

It is recommended to examine the quality and integrity of the IVT product on an 
agarose gel.

Aliquot and freeze the IVT transcripts at -80°C.  Avoid repeated freeze / thaw cycles.

Table 3.2.1

Conversions for Preparing 2.5 nM Control Transcript Mix

Control RNA Size (kb) Molecular Weight pMoles / µg

   Lys 1 330,000 3.03

   Phe 1.32 435,600 2.30

   Dap 1.82 607,200 1.65

   Thr 1.98 653,400 1.53

   Trp 2.5 kb 825,000 1.21

Since the hybridization mix has a volume of 200 µL, 10 pM would be the final 
concentration for the transcripts assuming 100% recovery throughout the 
enrichment and labelling procedure.   Alternatively, different concentrations of 
transcript stock can be prepared to generate “variable” concentrations for different 
transcripts to monitor the dynamic range of the assay.

Aliquot and freeze the IVT transcripts at -80°C.  Avoid repeated freeze / thaw cycles.
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E. coli Target Hybridization

Reagents and Materials Required .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.3.5

Reagent Preparation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.3.6

E. coli Target Hybridization   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 3.3.7

This Chapter Contains:

� Detailed steps for preparing the hybridization mix containing labeled target.

� Instructions for hybridizing the target mix to a GeneChip® E.coli Genome Array.

After completing the procedures described in this chapter, the hybridized probe array is 
then ready for washing, staining and scanning as detailed in Section 3, Chapter 4.
701032 rev 1 3.3.3
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Water, Molecular Biology Grade, BioWhittaker, P/N 16-001Y

� Acetylated Bovine Serum Albumin (BSA) solution (50 mg/mL), Invitrogen Life 
Technologies, P/N 15561-020

� Herring Sperm DNA, Promega Corporation, P/N D1811

� Micropure Separator, Millipore, P/N 42512 (optional)

� Control Oligo B2, 3 nM, Affymetrix, P/N 900301 (can be ordered separately)

� 5 M NaCl, RNase-free, DNase-free, Ambion, P/N 9760G

� MES Free Acid Monohydrate SigmaUltra, Sigma-Aldrich, P/N M5287 

� MES Sodium Salt, Sigma-Aldrich, P/N M5057

� EDTA Disodium Salt, 0.5 M solution (100 mL), Sigma-Aldrich, P/N E7889

Miscellaneous Reagents
� Tough Spots, Label Dots, USA Scientific, P/N 9185 (optional)

� Tween-20, 10%, Pierce Chemical, P/N 28320

Miscellaneous Supplies

� GeneChip® Hybridization Oven 640, Affymetrix, P/N 800139

� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific,
P/N 1415-2600 (or equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman or equivalent

� Sterile-barrier pipette tips and non-barrier pipette tips
3.3.5
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3.3.6
Reagent Preparation

12X MES Stock

(1.22 M MES, 0.89 M [Na+])

For 1000 mL:

70.4 g MES free acid monohydrate

193.3 g MES Sodium Salt

800 mL of Molecular Biology Grade water

Mix and adjust volume to 1000 mL.

The pH should be between 6.5 and 6.7. Filter through a 0.2 µm filter.

2X Hybridization Buffer

(Final 1X concentration is 100 mM MES, 1 M [Na+], 20 mM EDTA, 0.01% Tween 20)

For 50 mL:

8.3 mL of 12X MES Stock

17.7 mL of 5 M NaCl

4.0 mL of 0.5 M EDTA 

0.1 mL of 10% Tween 20

19.9 mL of water

Store at 2-8°C, and shield from light

 Do not autoclave, store at 2-8°C, and shield from light.  Discard solution if yellow.
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E. coli  Target Hybridization

After determining that the fragmented RNA is labeled with biotin, prepare the hybridization 
solution mix. The recommended amount of RNA per assay is 1.5 to 4.0 µg. The solution is 
stable for approximately 6 to 8 hours at 4°C. The following protocol can be used for freshly 
prepared or frozen hybridization cocktail. Re-use of prokaryotic sample is not 
recommended, since the samples are end-labeled rather than internally labeled.

1. Prepare the following hybridization solution mix.

2. Equilibrate probe array to room temperature immediately before use.

3. Add the hybridization solution mix to the probe array.

4. Place probe array in the hybridization oven set at 45°C.

5. Avoid stress to the motor; load probe arrays in a balanced configuration around 
rotisserie axis. Rotate at 60 rpm.

6. Hybridize for 16 hours.

During the latter part of the 16-hour hybridization, proceed to Section 3, Chapter 4 to 
prepare reagents required immediately after completion of hybridization.

Table 3.3.1 

Hybridization Solution Mix

Components Volume Final Concentration

2X MES Hybridization Buffer             100.0 µL 1X

3 nM Control Oligo B2                3.3 µL 50 pM

10 mg/mL Herring Sperm DNA                2.0 µL 0.1 mg/mL

50 mg/mL BSA                2.0 µL 0.5 mg/mL

Fragmented Labeled RNA            1.5 to 4.0 µg —

Molecular Biology Grade Water  to a final volume of 200 µL —

Final Volume                 200 µL

It is important to allow the arrays to normalize to room temperature completely. 
Specifically, if the rubber septa are not equilibrated to room temperature, they may be 
prone to cracking which can lead to leaks.

It is necessary to use two pipette tips when filling the probe array cartridge: one for 
filling, and the second to allow venting of air from the hybridization chamber. After the 
addition of hybridization cocktail, the septa may be covered with Tough Spots to 
prevent evaporation.
3.3.7
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GeneChip® E. coli Genome Array:
Washing, Staining and Scanning
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This Chapter Contains:

� Instructions for using the GeneChip® Fluidics Station to automate the washing and 
staining of GeneChip® E.coli Genome Arrays.

� Instructions for scanning probe arrays using the GeneArray® Scanner.

After completing the procedures described in this chapter, the scanned probe array image 
(.dat file) is ready for analysis, as explained in Section 4.
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Reagents and Materials Required

The following reagents and materials are recommendations and have been tested and 
evaluated by Affymetrix scientists. For supplier phone numbers in the U.S. and Europe, 
please refer to the Supplier and Reagent Reference List, Appendix A of this manual. 
Information and part numbers listed are based on U.S. catalog information. Additional 
reagents needed for the complete analysis are listed in the appropriate chapters. 
Appendix A contains a master list of all reagents used in this manual.

� Water, Molecular Biology Grade, BioWhittaker, P/N 16-001Y

� Distilled water, Invitrogen Life Technologies, P/N 15230-147

� Acetylated Bovine Serum Albumin (BSA) solution (50 mg/mL), Invitrogen Life 
Technologies, P/N 15561-020

� R-Phycoerythrin Streptavidin, Molecular Probes, P/N S-866

� 5 M NaCl RNase-free, DNase-free, Ambion, P/N 9760G

� PBS, pH 7.2, Invitrogen Life Technologies, P/N 20012-027

� 20X SSPE (3 M NaCl, 0.2 M NaH2PO4, 0.02 M EDTA), BioWhittaker, P/N 16-010Y

� Goat IgG, Reagent Grade, Sigma-Aldrich, P/N I 5256

� Anti-streptavidin antibody (goat), biotinylated, Vector Laboratories, P/N BA-0500

� 10% surfact-Amps20 (Tween-20), Pierce Chemical, P/N 28320

� Bleach (5.25% Sodium Hypochlorite), VWR Scientific, P/N 21899-504 (or equivalent)

� ImmunoPure Streptavidin, Pierce Chemical, P/N 21125

Miscellaneous Supplies
� Sterile, RNase-free, microcentrifuge tubes, 1.5 mL, USA Scientific, P/N 1415-2600 (or 

equivalent)

� Micropipettors, (P-2, P-20, P-200, P-1000), Rainin Pipetman (or equivalent)

� Sterile-barrier pipette tips and non-barrier pipette tips

� Tygon Tubing, 0.04″ inner diameter, Cole-Palmer, P/N H-06418-04
3.4.5
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Reagent Preparation

Stringent Wash Buffer

(100 mM MES, 0.1 M [Na+], 0.01% Tween 20)

For 1000 mL:

83.3 mL of 12X MES Stock Buffer (see Section 3, Chapter 3 for reagent preparation)

5.2 mL of 5 M NaCl

1.0 mL of 10% Tween 20

910.5 mL of water 

Filter through a 0.2 µm filter

Store at 2-8°C and shield from light

Non-Stringent Wash Buffer

(6X SSPE, 0.01% Tween 20)

For 1000 mL:

300 mL of 20X SSPE

1.0 mL of 10% Tween-20

698 mL of water

Filter through a 0.2 µm filter

2X Stain Buffer

(Final 1X concentration: 100 mM MES, 1 M [Na+], 0.05% Tween 20)

For 250 mL:

41.7 mL 12X MES Stock Buffer (see Section 3, Chapter 3 for reagent preparation)

92.5 mL 5 M NaCl

2.5 mL 10% Tween 20

112.8 mL water

Filter through a 0.2 µm filter

Store at 2-8°C and shield from light

10 mg/mL Goat IgG Stock

Resuspend 50 mg in 5 mL PBS

Store at 4°C

1 mg/mL Streptavidin Stock

Resuspend 5 mg in 5 mL of PBS

Store at 4°C
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Experiment and Fluidics Station Setup

Step 1:  Defining File Locations

Before working with Affymetrix® Microarray Suite it is important to define where the 
program stores and looks for files.

1. Launch Microarray Suite from the workstation and select Tools → Defaults → File 
Locations from the menu bar.

The File Locations window displays the locations of the following files:

� Probe Information (library files, mask files)

� Fluidics Protocols (fluidics station scripts)

� Experiment Data (.exp, .dat, .cel and .chp files are all saved to location selected here)

2. Verify that all three file locations are set correctly and click OK.

Contact Affymetrix Technical Support if you have any questions regarding this 
procedure.

Step 2:  Entering Experiment Information

To wash, stain and scan a probe array, an experiment must first be defined in the Microarray 
Suite.

1. Select Run → Experiment Info from the menu bar. Alternatively, click the New 
Experiment icon on the tool bar.

⇒ The Experiment Information dialog box appears allowing the experiment name to 
be defined along with several other parameters such as probe array type, sample 
description and comments.

2. Type in the Experiment Name. 

3. In the Probe Array Type box, click the arrow and select Ecoli from the drop-down 
list.

Experiment name and probe array type are required. Complete as much of the other 
information as desired. The protocol information at the bottom of the dialog box is 
exported to the experiment information dialog box after the hybridization and scan are 
complete.

4. Save the experiment by selecting Save.

The name of the experiment is used by Microarray Suite to access the probe array type 
and data for the sample while it is being processed. Data files generated for the sample 
are automatically labeled to correspond to the experiment name. Microarray Suite 
automatically fills in the Protocol section of this dialog box with information on array 
processing from the fluidics station.

5. Close the Experiment Information dialog box.
3.4.7
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Step 3:  Preparing the Fluidics Station

The GeneChip® Fluidics Station 400 is used to wash and stain the probe arrays. It is 
operated using Microarray Suite.

Setting Up the Fluidics Station

1. Turn on the Fluidics Station using the toggle switch on the lower left side of the 
machine.

2. Select Run → Fluidics from the menu bar. 

⇒ The Fluidics Station dialog box appears with a drop-down list for selecting the 
experiment name for each of the fluidics station modules. A second drop-down list 
is accessed for choosing the Protocol for each of the four fluidics station modules.

Priming the Fluidics Station

Priming ensures that the lines of the fluidics station are filled with the appropriate buffers 
and the fluidics station is ready for running fluidics station protocols.

Priming should be done:

� When the fluidics station is first started.

� When wash solutions are changed.

� Before washing, if a shutdown has been performed.

� If the LCD window instructs the user to prime.

1. To prime the fluidics station, select Protocol in the Fluidics Station dialog box.

2. Choose Prime for the respective modules in the Protocol drop-down list.

3. Change the intake buffer reservoir A to Non-stringent Wash Buffer and intake buffer 
reservoir B to Stringent Wash Buffer.

4. Click Run for each module to begin priming.

Refer to the GeneChip® Fluidics Station 400 User’s Guide for instructions on connecting 
and addressing multiple fluidics stations.
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Probe Array Wash and Stain

Following hybridization, the wash and stain procedures are carried out by the fluidics 
station using the ProkGE-WS2 fluidics script. The procedure takes approximately 75 
minutes to complete. The use of streptavidin in the first part of the stain procedure enhances 
the overall signal.

Preparing the Staining Reagents

1. Prepare the following stain and wash solutions the day of the procedure. The solutions 
are stable for approximately 6 to 8 hours at 4°C.  Volumes given are sufficient for one 
probe array.

Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C, either 
foil-wrapped or kept in an amber tube. Remove SAPE from refrigerator and tap the 
tube to mix well before preparing stain solution. Do not freeze SAPE. Always prepare 
the SAPE stain solution immediately before use.

Table 3.4.1 

Streptavidin Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0  µL 1X

50 mg/mL BSA 24.0  µL 2 mg/mL

1 mg/mL Streptavidin 6.0  µL 10 µg/mL

DI H20 270.0  µL —

Total Volume 600  µL
3.4.9
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Table 3.4.2 

Antibody Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0 µL 1X

50 mg/mL BSA 24.0 µL 2 mg/mL

10 mg/mL Normal Goat IgG 6.0 µL 0.1 mg/mL

0.5 mg/mL Biotin Anti-streptavidin 6.0 µL 5 µg/mL

DI H20 264.0 µL —

Total Volume 600  µL

Table 3.4.3 

SAPE Solution Mix

Components Volume Final Concentration

2X MES Stain Buffer 300.0 µL 1X

50 mg/mL BSA 24.0 µL 2 mg/mL

1 mg/mL Streptavidin-Phycoerythrin 6.0 µL 10 µg/mL

DI H20 270.0 µL —

Total Volume 600  µL

Table 3.4.4

Fluidics Protocols -Antibody Amplification for E. coli Targets

Standard Format

ProkGE-WS2

Post Hyb 
Wash #1

10 cycles of 2 mixes/cycle with Wash Buffer A at 25oC

Post Hyb 
Wash #2

4 cycles of 15 mixes/cycle with Wash Buffer B at 45oC

Stain Stain the probe array for 10 minutes in Streptavidin Solution. Mix at 25oC

Post Stain 
Wash

10 cycles of 4 mixes/cycle with Wash Buffer A at 30oC

2nd Stain Stain the probe array for 10 minutes in antibody solution. Mix at 25°C.

3rd Stain Stain the probe array for 10 minutes in SAPE Solution at 25oC

Final Wash 15 cycles of 4 mixes/cycle with Wash Buffer A at 30oC.  The holding temperature is 25oC.

• Wash Buffer A = non-stringent wash buffer
• Wash Buffer B = stringent wash buffer
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2. In the Fluidics Station dialog box on the workstation, select the correct experiment 
name from the drop-down Experiment list. The probe array type will appear 
automatically.

3. In the Protocol drop-down list, select the ProkGE-WS2 protocol to control the 
washing and staining of the probe array format being used.

4. Choose Run in the Fluidics Station dialog box to begin the washing and staining. 
Follow the instructions in the LCD window on the fluidics station.

If you are unfamiliar with inserting and removing probe arrays from the fluidics station 
modules, please refer to the GeneChip® Fluidics Station 400 User’s Guide.

5. Insert the appropriate probe array into the designated module of the fluidics station 
while the probe array lever is in the EJECT position. When finished, verify that the 
probe array lever is returned to the ENGAGE position.

6. Remove any microcentrifuge tube remaining in the sample holder of the fluidics station 
module(s) being used.

7. Place a microcentrifuge tube containing 600 µL streptavidin solution into the sample 
holder, making sure that the metal sampling needle is in the tube with its tip near the 
bottom.

⇒ The Fluidics Station dialog box and the LCD window display the status of the 
washing and staining as they progress.

8. When the LCD window indicates, replace the microcentrifuge tube containing the 
streptavidin stain with a microcentrifuge tube containing 600 µL antibody stain 
solution into the sample holder, making sure that the metal sampling needle is in the 
tube with its tip near the bottom.

9. When the LCD window indicates, replace the microcentrifuge tube containing 
antibody solution with the microcentrifuge tube containing the 600 µL of SAPE 
solution.

10. When the protocol is complete, the LCD window displays the message EJECT 
CARTRIDGE.

11. Remove microcentrifuge tube containing stain and replace with an empty 
microcentrifuge tube.

12. Remove the probe arrays from the fluidics station modules by first moving the probe 
array holder lever to the EJECT position. When finished, verify that the probe array 
holder is returned to the ENGAGE position.

13. Check the probe array window for large bubbles or air pockets. If bubbles are present, 
refer to Table 3.4.5 on page 3.4.12.

14. If the probe array has no large bubbles, it is ready to scan on the GeneArray® Scanner. 
Scan according to Probe Array Scan on page 3.4.13. If there are no more samples to 
hybridize, shut down the fluidics station following the procedure in Shutting Down the 
Fluidics Station on page 3.4.14.

15. Keep the probe arrays at 4°C and in the dark until ready for scanning.

Three-stain protocols require the user to replace stain solutions as directed by the LCD 
window during staining steps.
3.4.11
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16. ENGAGE wash block.

For proper cleaning and maintenance of the fluidics station, including the bleach 
protocol, refer to Section 5, Fluidics Station Maintenance Procedures.

Table 3.4.5

If bubbles are present

Return the probe array to the probe array holder. Latch the probe array holder by gently 
pushing it up until a light click is heard. Engage the washblock by firmly pushing up on the 
probe array lever to the ENGAGE position.
The fluidics station will drain the probe array and then fill it with a fresh volume of the last 
wash buffer used. When it is finished, if the LCD window displays EJECT CARTRIDGE 
again, remove the probe array and inspect it again for bubbles. If no bubbles are present, it is 
ready to scan. Proceed to Probe Array Scan on page 3.4.13.
If several attempts to fill the probe array without bubbles are unsuccessful, the array should 
be filled with Wash A (non-stringent buffer) manually. Excessive washing will result in a 
loss of signal intensity. Contact Affymetrix Technical Support for details on the procedure. 
Remove the probe array and run the CLEAN procedure on the particular module before 
starting a new hybridization. 



CHAPTER 4   GeneChip® E. coli Genome Array: Washing, Staining and Scanning

E
. 

c
o

li
Probe Array Scan

The scanner is also controlled by Affymetrix® Microarray Suite. The probe array is scanned 
after the wash protocols are complete. Make sure laser is warmed up prior to scanning by 
turning the laser on at least 15 minutes before use. If probe array was stored at 4°C, warm to 
room temperature before scanning. Refer to the Microarray Suite online help and the 
appropriate scanner user’s manual for more information on scanning.

If necessary, clean the glass surface of probe array with a non-abrasive towel or tissue 
before scanning. Do not use alcohol to clean glass.

1. Select Run → Scanner from the menu bar. Alternatively, click the Start Scan icon in 
the tool bar.

⇒ The Scanner dialog box appears with a drop-down list of experiments that have not 
been run. A scrollable window is also displayed showing previous scans. 

2. Select the experiment name that corresponds to the probe array to be scanned. A 
previously run experiment can also be chosen from the Previous Experiments list by 
double-clicking the name desired.

3. To perform the recommended 2X Image scan, a [2] must be entered into the box for 
Number of Scans.

4. Click the Options button in the Scanner dialog box to check for the correct pixel value 
and wavelength of the laser beam.

� Pixel value = 3 µm

� Wavelength = 570 nm

5. Once the experiment has been selected, click the Start button.

⇒ A dialog box prompts you to load a sample into the scanner.

6. Open the sample door on the scanner and insert the probe array into the holder. Do not 
force the probe array into the holder. Close the sample door of the scanner.

7. Click OK in the Start Scanner dialog box.

⇒ The scanner begins scanning the probe array and acquiring data. When Scan in 
Progress is Selected from the View menu, the probe array image appears on the 
screen as the scan progresses.

The scanner uses an argon-ion laser and is equipped with a safety interlock system. 
Defeating the interlock system may result in exposure to hazardous laser light.
3.4.13
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Shutting Down the Fluidics Station

1. After removing a probe array from the probe array holder, the LCD window displays 
the message ENGAGE WASHBLOCK. 

2. Engage the washblock by firmly pushing up on the probe array lever to the ENGAGE 
position.

The fluidics station will automatically perform a Cleanout procedure. The LCD 
window will indicate the progress of the Cleanout procedure.

3. When the fluidics station LCD window indicates REMOVE VIAL, the Cleanout 
procedure is complete.

4. Remove the sample microcentrifuge tube from the sample holder.

5. If no other hybridizations are to be performed, place wash lines into a bottle filled with 
deionized water.

6. Select Shutdown for all modules from the drop-down Protocol list in the Fluidics 
Station dialog box. Click the Run button for all modules.

The Shutdown protocol is critical to instrument reliability. Refer to the Affymetrix 
GeneChip® Fluidics Station 400 User’s Guide for more information. 

7. After Shutdown protocol is complete, flip the ON/OFF switch of the fluidics station to 
the OFF position.

To maintain the cleanliness of the fluidics station and obtain the highest quality image 
and data possible, a weekly bleach protocol and a monthly decontamination protocol 
are highly recommended.  Please refer to Section 5, Fluidics Station Maintenance 
Procedures for further detail.
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Customizing the Protocol

There may be times when the fluidics protocols need to be modified. Modification of 
protocols must be done before downloading the protocol to the fluidics station. Protocol 
changes will not affect runs in progress. For more specific instructions, refer to the 
Microarray Suite online help.

1. Select Tools → Edit Protocol from the menu bar.

2. In the Edit Protocol dialog box under Protocol Name, click the arrow to open a list of 
protocols. Click the protocol to be changed.

⇒ The name of the protocol is displayed in the Protocol Name text box. The 
conditions for that protocol are displayed on the right side of the Edit Protocol 
dialog box.

3. Select the item to be changed and input the new parameters as needed, keeping 
parameters within the ranges shown below in Table 3.4.6.

4. To return to the default values for the protocol selected, click the Defaults button.

5. Once all the protocol conditions are modified as desired, change the name of the edited 
protocol in the Protocol Name box.

6. Click Save, then close the dialog box.

Enter 0 (zero) for hybridization time if hybridization step is not required. Likewise, 
enter 0 (zero) for the stain time if staining is not required. Enter 0 (zero) for the number 
of wash cycles if a wash solution is not required.

Table 3.4.6

Valid Ranges for Wash/Stain Parameters

Parameter Valid Range

Wash Temperature for A1, B, A2 or A3 (°C) 15 to 50

Number of Wash Cycles for  A1, B, A2 or A3 0 to 99

Mixes / Wash cycle for  A1, B, A2 or A3 15 to 50

Stain Time (seconds) 0 to 86,399

Stain Temperature (°C) 15 to 50

Holding Temperature (°C) 15 to 50

• Wash A1 corresponds to Post Hyb wash #1 in Table 3.4.4.
• Wash B corresponds to Post Hyb wash #2 in Table 3.4.4.
• Wash A2 corresponds to Post Stain Wash in Table 3.4.4.
• Wash A3 corresponds to Final Wash in Table 3.4.4.

If the protocol is saved without entering a new Protocol Name, the original protocol 
parameters will be overwritten.
3.4.15
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Probe Set Masking   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  4.1.20

Creation and Use of Probe Set Mask Files  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  4.1.20

File Types .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  4.1.21

Probe Information Files .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  4.1.21
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This Chapter Contains:

� Guidelines for setting up the Absolute Analysis (one probe array) and the Comparison 
Analysis (two probe arrays) using the Affymetrix® Microarray Suite.

After completing the procedures described in this chapter, the analyzed probe array data 
(.chp file) contains the results and the algorithms used by Affymetrix Microarray Suite.
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4.1.4
Overview

This is a brief overview of the capabilities of Affymetrix® Microarray Suite (MAS) and 
previously GeneChip® Analysis Suite software. For more detailed descriptions of these 
features, refer to the Affymetrix Microarray Suite User’s Guide (P/N 700293), online help or 
contact Affymetrix Technical Support.

After scanning the probe array, the resulting image data created is stored on the hard drive 
of the GeneChip® Analysis Suite/Microarray Suite workstation as a .dat file with the name 
of the scanned experiment. In the first step of the analysis, a grid is automatically placed 
over the .dat file demarcating each probe cell. One of the probe array library files, the .cif 
file, is used by Microarray Suite to determine the appropriate grid size used. Confirm the 
alignment of the grid by zooming in on each of the four corners and on the center of the 
image.

If the grid is not aligned correctly, adjust the alignment by placing the cursor on an outside 
edge or corner of the grid. The cursor image will change to a small double-headed arrow. 
The grid can then be adjusted using the arrow keys on the keyboard or by clicking and 
dragging the borders with the mouse.

The procedures for GeneChip expression analysis differ slightly whether you are running 
GeneChip® Analysis Suite software or Affymetrix® Microarray Suite. The procedures for 
each are described below.

GeneChip® Analysis Suite

GeneChip® Analysis Suite analyzes the hybridization intensity data from GeneChip® 
expression probe arrays and calculates a set of metrics that describe probe set performance.

In an absolute expression analysis,  GeneChip Analysis Suite examines the hybridization 
intensity data from one experiment (probe array) to calculate a set of absolute metrics. 
Some of the metrics are used by a decision matrix to determine an Absolute Call for each 
transcript: Present (P), Absent (A), or Marginal (M).

In a comparison expression analysis,  GeneChip Analysis Suite examines the hybridization 
intensity data from two probe arrays (an experiment and a baseline of the same probe array 
type) to calculate a set of comparison metrics. Some of the metrics are used by a decision 
matrix to determine a Difference Call for each transcript: Increased (I), Decreased (D), 
Marginally Increased (MI), Marginally Decreased (MD), or No Change (NC). A fold 
change calculation is also computed to indicate the relative change of each transcript 
represented on the probe array.
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Analyzing Samples

1. Select Tools → Defaults.

⇒ The Probe Array Call Settings dialog box appears.

2. In the Defaults dialog box, click the Probe Array Call Settings tab to display probe 
array setting algorithm options.

3. Highlight GeneChip Expression and click the Modify button or double-click the 
algorithm name.

4. In the Expression Call Settings dialog box, select the Probe Array Type in the drop-
down list.

5. For the probe array chosen, verify that the Use As Current Algorithm option box is 
selected.

6. Select desired options in the Scale, Normalize, Probe Mask, Baseline, and 
Parameters tabs.

By selecting the Prompt for Output Filename option in the Algorithm Parameters 
section of the dialog box, the software automatically ask for a file name to assign to the 
.chp file when an analysis is requested. Selecting the Display Settings When 
Analyzing Data option automatically opens the Expression Call Settings dialog box 
for review when an analysis is requested from an open .dat file.

7. In the Expression Call Settings dialog box, click the OK button to apply your choices 
regarding parameters set by all of the tab dialog boxes in the window. Next, select OK 
in the Defaults dialog box.

8. Select Run → Analysis, or click the Analyze button  on the main tool bar.

The software calculates the average intensity of each probe cell using the intensities of 
the pixels contained in the cell. Pixels on the edges of each cell are not included, which 
prevents neighboring cell data from affecting a cell’s calculated average intensity. The 
calculated average intensity is assigned an X/Y-coordinate position, which corresponds 
to the cell’s position on the array. This data is stored as a .cel file using the same name 
as the .exp and .dat files. The .cel file is an intermediate data file.

The software then applies the selected probe array algorithm to determine expression 
levels for each gene. This is done with reference to the information contained in the 
.cdf file, the second library file for the probe array. The resulting analysis is 
automatically displayed as a .chp file in the Expression Analysis window of GeneChip 
Analysis Suite software. See File Types on page 4.1.21 for definitions of these files.
4.1.5
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4.1.6
Comparison Analysis

In a comparison analysis, one experiment is defined as a baseline and is then used in 
comparison to a second experiment. The experiment to be used as a baseline must have a 
.chp file already generated.

1. From the menubar, select Tools → Defaults → Probe Array Call Settings.

2. Highlight GeneChip Expression and click the Modify button.

3. Select the correct probe array type from the drop-down list, then click the Baseline tab.

4. Select the Use Baseline Comparison File option box, then click the Browse button.

⇒ A dialog box appears displaying the .chp files in the Experimental Data folder.

5. Select the .chp file to be used as a baseline file in your comparison, then click Open, or 
double-click the .chp file name, then click OK.

6. Open the .dat or .cel file of the experiment to be analyzed. Select Run → Analysis.

It is possible to select the columns of data output shown in a .chp file. With a .chp file 
open in the Expression Analysis window, choose Options from the Analysis menu and 
select the Table Data tab. Select or clear the data output columns by double-clicking the 
column names.
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Affymetrix® Microarray Suite

Affymetrix® Microarray Suite analyzes the hybridization intensity data from GeneChip® 
expression probe arrays and calculates a set of metrics that describe probe set performance.

In an absolute expression analysis,  Microarray Suite examines the hybridization intensity 
data from one experiment (probe array) to calculate a set of absolute metrics. Some of the 
metrics are used by a decision matrix to determine an Absolute Call for each transcript: 
Present (P), Absent (A), or Marginal (M).

In a comparison expression analysis, Microarray Suite examines the hybridization intensity 
data from two probe arrays (an experiment and a baseline of the same probe array type) to 
calculate a set of comparison metrics. Some of the metrics are used by a decision matrix to 
determine a Difference Call for each transcript: Increased (I), Decreased (D), Marginally 
Increased (MI), Marginally Decreased (MD), or No Change (NC). A “Fold Change” 
calculation is also computed to indicate the relative change of each transcript represented 
on the probe array.

Expression Analysis Settings

Prior to an absolute or comparison analysis, confirm or specify new values for the 
expression analysis settings. These settings include scaling and normalization factors, probe 
mask definition, baseline file selection, and values for the user-modifiable parameters of the 
expression analysis algorithm. The algorithm relies on the expression analysis settings to 
derive biologically meaningful results from the hybridization intensity data. 

Viewing the Expression Analysis Settings

1. Click Analysis Settings in the shortcut bar, then click the Expression 
Analysis button  (Figure 4.1.14). 

⇒ The Expression Analysis Settings dialog box appears (Figure 4.1.1).

2. Click a tab to view each type of setting.

The expression analysis settings are saved on a per user basis. Changes made by one 
user (as identified by the logon name) do not affect the settings of other users.

Refer to the Microarray Suite User’s Guide for further information on how to change 
the settings.
4.1.7
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4.1.8
 

Running an Absolute Expression Analysis

An absolute expression analysis examines the cell intensity file (.cel) from one experiment 
(probe array) and determines whether the transcripts represented on the probe array are 
present, absent, or marginal in the target (sample).

1. Right-click the desired .cel or .dat file in the data file tree, then select Analyze from the 
shortcut menu. 

Alternatively, if the image is displayed, click the Analyze button  in the main 
toolbar, or select Run → Analysis from the main menu.

⇒ The Save Results As dialog box appears, if chosen as a default option (see 
Microarray Suite Default Settings Dialog on page 4.1.15). It displays the analysis 
output file (.chp) default name, which is the same as the experiment name specified 
during experiment setup (Figure 4.1.2).

2. Enter a new name if an analysis was previously run and you wish to save the current 
results without overwriting the previous results. Click OK.

⇒ The Expression Analysis Settings dialog box appears (Figure 4.1.3), if set as a default 
option (see Microarray Suite Default Settings Dialog on page 4.1.15).

Figure 4.1.1    

Expression Analysis Settings dialog box, Scaling tab

Figure 4.1.2    

Save Results As dialog box
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3. Click the Baseline tab of the Expression Analysis Settings dialog box and verify that 
the Use Baseline Comparison File option is cleared (Figure 4.1.3).

4. To compare the analysis output files (.chp) of several experiments, scale the 
experiments to the same target intensity using the All Probe Sets or Selected Probe 
Sets option found on the Scaling tab.

5. Confirm or change the other Expression Analysis Settings as desired.

6. Click OK to close the Expression Analysis Settings dialog box and run the absolute 
analysis.

During the analysis, the status window displays the name of the analysis output file 
(.chp) being generated and where it will be stored. The status window also indicates 
when the analysis is completed.

If the status bar is not displayed, click the Status Log button  in the main toolbar or 
select View → Status Bar from the main menu.

When the analysis is finished, the Expression Analysis window (EAW) appears and 
displays the analysis output file (.chp) (Figure 4.1.4). If the EAW is already open, the 
results are added to the open window and it may be necessary to use the scroll bars at 
the bottom and right side of the EAW to see the newly added results. 

The Save Results As and Expression Analysis Settings dialog boxes are only 
displayed when chosen as default options and when the Run → Analysis main
 menu commands are used to run an analysis.

Figure 4.1.3    

Expression Analysis Settings, Baseline tab
4.1.9
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4.1.10
Running a Comparison Expression Analysis

A comparison expression analysis compares the cell intensity data (.cel file) of an 
experiment and baseline probe array (of the same probe array type). The comparison 
analysis identifies relative changes in the expression level of each transcript represented on 
the arrays.

Absolute Expression Analysis of the Baseline

1. In the data file tree, right-click the baseline cell intensity file (.cel) and then select 
Analyze from the pop-up menu. 

Alternatively, if the image is displayed, click the Analyze button  in the main 
toolbar or select Run → Analysis from the main menu.

⇒ The Save Results As dialog box appears, if chosen as a display option (see 
Microarray Suite Default Settings Dialog on page 4.1.15). It displays the analysis 
output file (.chp) default name, which is the same as the experiment name specified 
during experiment setup (Figure 4.1.5).

Figure 4.1.4    

Expression Analysis Window (EAW), Pivot tab

An absolute expression analysis of the baseline must be run prior to running a 
comparison analysis of the experiment and baseline.
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Enter a new name if an analysis was previously run and you wish to save the current 

results without overwriting the previous results. Click OK.

⇒ The Expression Analysis Settings dialog box appears (Figure 4.1.6), if chosen as a 
default option (see Microarray Suite Default Settings Dialog on page 4.1.15). 

2. Click the Baseline tab and verify that the Use Baseline Comparison File option is 
cleared (Figure 4.1.6).

3. Confirm or change the other Expression Analysis settings as desired.

4. If the baseline was not scaled, specify a normalization option for the experiment. 

5. Click OK to close the Expression Analysis Settings dialog box and run the absolute 
analysis of the baseline.

During the analysis, the status window displays the name of the analysis output file (.chp) 
being generated and where it will be stored. The status window also indicates when the 
analysis is completed.

Figure 4.1.5    

Save Results As dialog box

The Save Results As and Expression Analysis Settings dialog boxes 
are only displayed when chosen as default options and when the Analyze button   
or Run → Analysis main menu commands are used to run an analysis.

Figure 4.1.6    

Expression Analysis Settings, Baseline tab
4.1.11
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4.1.12
If the status bar is not displayed, click the Status Log button  in the main toolbar or 
select View → Status Bar from the main menu.

When the analysis is finished, the Expression Analysis window (EAW) opens and displays 
the analysis output file (.chp) (Figure 4.1.4). If the EAW is already open, the results are added 
to the open window and it may be necessary to use the scroll bars at the bottom and right 
side of the EAW to see the newly added results.

Comparison Expression Analysis of the Experiment and Baseline

1. In the data file tree, right-click the experiment cell intensity file (.cel) and select 
Analyze from the pop-up menu. 

Alternatively: 1) select File → Analysis from the main menu and choose the desired 
.cel file from the Analyze dialog box that appears, or 2) if the image is displayed, click 
the Analyze button , or select Run → Analysis from the main menu.

⇒ The Save Results As dialog box appears, if chosen as a default option. It displays 
the analysis output file (.chp) default name, which is the same as the experiment 
name specified during experiment setup (Figure 4.1.7).

2. Enter a new name if an analysis was previously run and you wish to save the current 
results without overwriting the previous results. Click OK.

⇒ The Expression Analysis Settings dialog box appears (Figure 4.1.8), if chosen as a 
default option. 

3. Click the Baseline tab of the Expression Analysis Settings dialog box and select the 
Use Baseline Comparison File option (Figure 4.1.8).

Figure 4.1.7    

Save Results As dialog box

The Save Results As and Expression Analysis Settings dialog boxes are only 
displayed when chosen as default options and when the Analyze button  or 
Run → Analysis main menu commands are used to run an analysis. 
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4. Click Browse.

⇒ The Baseline Comparison File dialog box appears (disk files mode) or the Open 
dialog box appears (LIMS mode) (Figure 4.1.9).

5. Select the baseline file and click Open or OK (or double-click the file name).

⇒ The Expression Analysis Settings dialog box displays the selected baseline file 
(Figure 4.1.10).

Figure 4.1.8    

Expression Analysis Settings, Baseline tab

Figure 4.1.9    

Baseline Comparison File dialog box, file mode (left) and Open dialog box, LIMS mode (right)
4.1.13
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4.1.14
6. Click the Normalization tab and specify the normalization option for the experimental 
data. The scaling option may be used instead of normalization, however, baseline 
should already be scaled if using the scaling option (refer to Affymetrix® Microarray 
Suite User’s Guide for a discussion of normalization and scaling).

7. Confirm or specify other probe array analysis parameters as desired.

8. Click OK to close the Expression Analysis Settings dialog box and run the comparison 
analysis.

During the analysis, the status window displays the name of the analysis output file (.chp) 
being generated and where it will be stored. The status window also indicates when the 
analysis is completed.

If the status bar is not displayed, click the Status Log button  in the main toolbar or 
select View → Status Bar from the main menu.

When the analysis is finished, the Expression Analysis window (EAW) opens and displays 
the comparison analysis output file (.chp) (Figure 4.1.11). If the EAW is already open, the 
results are added to the open window and it may be necessary to use the scroll bars at the 
bottom and right sides of the EAW to see the newly added results.

Figure 4.1.10    

Expression Analysis Settings, Baseline tab displays the baseline file for the expression comparison analysis

You need only specify a normalization option for the experiment, not the baseline. 
When using scaling instead of normalization, scale both the experiment and the 
baseline.



CHAPTER 1   Data Analysis

D
a
ta

 A
n

a
ly

si
s

Microarray Suite Default Settings Dialog

1. Select Tools  →  Defaults from the main menu to open the Defaults dialog box.

⇒ The Defaults dialog box appears.

2. Click the Analysis Settings tab (Figure 4.1.12).

� Prompt for Output File Name: Choose this option to display a Save Results As 
dialog box at the start of an analysis (only when Run → Analysis main menu 
commands are used to run the analysis).

� Display settings when analyzing data: Choose this option to display the 
Expression Analysis Settings dialog box at the start of each analysis (Figure 4.1.13). 

Figure 4.1.11    

EAW, metrics tab, comparison analysis output file (.chp)

Figure 4.1.12    

Defaults, Analysis Settings tab
4.1.15
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4.1.16
Probe Array Analysis

In the Analysis Settings shortcut bar, click a button to view or change user-modifiable 
parameters of the probe array analysis algorithms.

Figure 4.1.13    

Expression Analysis Settings dialog box

Figure 4.1.14     

Analysis Settings shortcut bar
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Probe Pair and Probe Set Masking in 
GeneChip® Expression Analysis

Affymetrix® Microarray Suite allows the user to define files called “mask files” which may 
be useful during array analysis. Two types of mask files can be employed, Probe Mask files 
and Probe Set Mask files. Probe Mask files designate specific probe pairs which are to be 
excluded from analysis, while Probe Set Mask files define specific probe sets for use 
during data scaling and normalization. These two types of mask files, quite distinct from 
one another in their functions, can be useful tools to enhance GeneChip® Expression 
Analysis at both the absolute (intra-array) and the comparison (inter-array) level. Both 
Probe Mask and Probe Set Mask files (format: .msk) are written to the Probe Information 
file directory, which by default is C:\GeneChip\Library. It is important to note that, 
although the two types of mask files share the same filename format and location, they are 
not interchangeable.

Probe Masking

Purpose: Probe masking is a feature that allows the user to exclude groups of probe pairs 
from the analysis of a specific probe array type.

Why is Probe Masking helpful? The probe pairs synthesized on GeneChip® Expression 
Analysis arrays are all a priori selected based on sequence information derived from public 
sequence databases (or proprietary databases in the case of custom Expression Analysis 
arrays) available at the time of the array design. Infrequently, certain probe pairs may be 
identified which fail to hybridize. There may also be cases where excessively large intensity 
differences are observed, or even negative intensity differences (i.e. mismatch probes 
giving excess hybridization signal over their perfect match counterparts). Although the 
GeneChip Expression Analysis algorithm has been designed to tolerate these events, such 
probe pairs may not add information to the determination of the expression state or 
quantitative expression level of the target gene. Occasionally, such aberrant probe pairs may 
bias certain analysis metrics (e.g. Positive Fraction, Log Average Ratio, etc.), adversely 
affecting sensitivity of detection. Many reasons for this unpredictable hybridization 
behavior are possible in complex biological systems. The result will be probe pair(s) which, 
lacking a target, do not show anticipated hybridization signal. Once identified, the 
uninformative probe pairs may be removed from subsequent analyses by using a Probe 
Mask, providing a mechanism to customize probe sets for optimum performance in a 
particular application.

Creation and Use of Probe Mask Files

Users may create Probe Mask files using Affymetrix Microarray Suite software, or 
Affymetrix may supply them for specific applications. Once created, the Probe Mask file is 
invoked from the Probe Mask tab of the Expression Analysis Settings dialog box. Check 
Use Probe Mask File and then browse and select the desired file from the list. The selected 
mask file will appear in the Probe Mask file field and the probe pairs which had been 
specified for masking will not be used in the analysis. This will be reflected in the Pairs 
Used column of the analysis results. For example, if there are 20 total probe pairs (Pairs) in 
a probe set and two pairs are masked with a Probe Mask, then the Pairs Used will be 18 for 
that probe set. Probe Mask use is recorded under View/parameters.
4.1.17
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4.1.18
Procedure to Create a Custom Probe Mask

A Probe Mask may be created from the Expression Analysis Settings dialog box by 
choosing the appropriate probe array type, and then selecting the Probe Mask tab and the 
Create/Open Probe Mask button. To create a new Probe Mask, enter the name for the new 
mask file in the File Name field of the Probe Mask File dialog box. In order to edit a 
previously created Probe Mask file, simply select the file from the list in the window. 
Choose Open to create or edit the selected file (Figure 4.1.15).

The Probe Mask Definition dialog box (Figure 4.1.16) allows the user to define the probe pairs 
for exclusion from analysis. There are four ways to generate Probe Mask files. The first is 
manual selection of the probe pairs. In addition to the manual method, there are three 
utilities for creating Probe Mask files.

Figure 4.1.15    

Expression Analysis Settings dialog box

Only mask files from the current Probe Information folder will be automatically 
displayed in this window. To edit mask files stored in other locations, use the Look in 
drop-down list to locate the folder containing the desired file.
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Defining the Probe Mask File Manually

Probe Mask files may be generated manually by selecting the desired probe set from the 
Probe Sets drop-down list, then defining the particular probe pairs to be excluded from 
analysis in the Probe Pairs field (format “1-3,7”). Once the selection from the current 
probe set has been completed, click within the main field of the dialog box to accept the 
selection. It will then be added to the list in this field. The process is repeated for each probe 
set which will have probe pairs masked until the list in the main field represents the 
complete list of Probe Sets and Probe Pairs to be masked. Select OK to end selection and 
save the Probe Mask file.

Using Cross Hyb..., Hyb... and Spike... to Generate Probe Mask Files

There are also three probe mask creation utilities: Cross Hyb..., Hyb..., and Spike.... Each 
of these utilities allows the user to automatically create Probe Mask files based on user-
defined probe pair hybridization characteristics in control experiments.

Cross Hyb...

The cross hybridization probe mask generator allows the user to conduct control 
experiments in order to detect cross hybridization occurring in the presence of specific 
transcripts. Probe pairs observed to exhibit cross-hybridization with the control sample 
based on these experiments are automatically added to a Probe Mask file. For example, we 
may wish to determine whether certain control transcripts cross-hybridize with other probes 
on an array. The Cross Hyb function adds any such probe pairs to the Probe Mask file based 
on a user defined Upper Intensity Limit. This is an advanced feature to assist in mask 
creation. Contact Affymetrix Technical Support for assistance with this utility.

Figure 4.1.16    

Probe Mask Definition dialog box
4.1.19
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4.1.20
Hyb…

The hybridization probe mask generator allows the user to generate Probe Mask files that 
include only those probe pairs which meet hybridization characteristics, based on the 
Difference Threshold and Ratio Threshold values that are user-defined. Subsequent 
analyses using hybridization masks will be based solely on the probe pairs which were 
identified as performing to a specified level. All other probe pairs are masked. This is an 
advanced feature to assist in mask creation. Contact Affymetrix Technical Support for 
assistance with this utility.

Spike…

The Spike probe mask generator allows the user to generate Probe Mask files that exclude 
probe pairs from analysis based on differential hybridization characteristics between a 
sample with and without a specific transcript spike. The hybridization characteristics are 
based on Difference Threshold and Ratio Threshold values that are user-defined. This is 
an advanced feature to assist in mask creation. Contact Affymetrix Technical Support for 
assistance with this utility.

Probe Set Masking

Purpose: Probe Set masking is used to select particular probe sets for use in comparison 
analysis during data scaling (or normalization).

Why is Probe Set Masking Helpful? Signal intensity may vary between experiments due 
to many factors, such as sample and/or stain concentration variance. Scaling (or 
normalization) is a process through which a factor is calculated that, when applied to all 
intensity values on an array, will allow experiments to be accurately compared. Using Probe 
Set masks, the user defines which probe sets on an array will be used for the scaling (or 
normalization) calculation. Scaling (or normalization) factor computation is based on an 
average of the Average Difference values of the selected probe sets relative to some target 
value. Different scaling (or normalization) strategies may be employed from time to time 
and the optimum strategy will vary depending on the application. Probe Set masking allows 
the scaling (or normalization) process to be customized for a particular experiment.

Creation and Use of Probe Set Mask Files

A Probe Mask may be created from the Expression Analysis settings dialog box by 
choosing the appropriate probe array type, and then selecting the Scaling/Normalization 
tabs and the Create/Open Probe Set Mask button. To create a new Probe Set Mask, enter 
the name for the new file in the File Name field in the Probe Set Mask File dialog box. To 
edit a previously created Probe Set Mask file, simply select the file from the list in the 
window. Choose Open to create or edit the selected file. 

The Probe Set Mask Definition dialog box allows the user to choose probe sets for inclusion 
in the mask file. Move the appropriate probe sets from the Exclude field to the Include 
field. Click OK to create the mask file.

Only the mask files from the current Probe Information folder will be automatically 
displayed in this window. To edit mask files stored in other locations use the Look in 
drop down list to locate the folder containing the desired file.
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Once created, the Probe Set Mask file is invoked from the Scaling (or Normalization) tab of 
the Expression Analysis Settings dialog box. Choose the Selected Probe Sets radio button, 
then browse and select the desired file. The selected mask file will appear in the Probe Set 
Mask file field.

File Types

Probe Information Files

1. .cif – chip information file. Contains grid size and parameters for analysis and scanner 
settings. Do not change any information in this file.

2. .cdf – chip description file.

3. .msk – mask file. This is a user defined file which permits the user to select a subset of 
probes for analysis, or a subset of genes for normalization and/or scaling.

To access these files, select Tools → Defaults from menu bar. Select the Probe 
Information line in the File Locations tab and click the Modify button. Map to the 
appropriate directory to allow Microarray Suite to access the desired files.

Test Data Files

1. .exp – experimental information file. Information about experiment name, sample and 
probe array are stored in this file. The experiment name then becomes the file name for 
subsequent files generated in the analysis.

2. .dat – data file. The image of the scanned probe array is stored in this file.

3. .cel – cell intensity file. This file is created by aligning the grid and running the 
analysis. The analysis calculates the average intensities of each cell and assigns it to an 
x, y coordinate position. The .cel files can be used to re-analyze data with different 
expression algorithm parameters.

4. .chp – analysis output file (chip file). This output is generated by the analysis of a .dat 
or .cel file. The .chp file contains the absolute analysis and may contain the comparison 
analysis. The absolute analysis determines which transcripts are present or absent in a 
sample and the comparison analysis determines which transcripts are increased or 
decreased between samples.

To access these files, select Tools → Defaults from menu bar. Select the Experiment Data 
line in the File Locations tab and click the Modify button. Map to the appropriate directory 
to allow Microarray Suite to access the desired files.
4.1.21
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Fluidics Station Maintenance Procedures

Weekly Fluidics Station Cleanout.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 5.1.4

Bleach Protocol .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 5.1.4

Monthly Fluidics Station Decontamination Protocol .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 5.1.5

This Section Contains:

� A weekly fluidics station bleach protocol.

� A monthly fluidics station decontamination protocol.
701041 rev 1 5.1.3
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5.1.4
Weekly Fluidics Station Cleanout

A cleaning protocol is recommended for fluidics station maintenance if the antibody 
staining procedure is used. Choose Bleach for all modules from the drop-down list in the 
Fluidics Station dialog box. Click the Run button for all modules and follow LCD 
instructions.

Bleach Protocol 

This protocol is designed to eliminate any residual SAPE-antibody complex that may be 
present in the fluidics station tubing and needles. We recommend running this protocol at 
least once a week.

1. Prepare 1 liter of 0.525% sodium hypochlorite solution using distilled water. Shake 
well.

2. Cut at least two feet of plastic tubing for each module of each fluidics station. These 
can be reused for subsequent BLEACH runs.

3. Place all three wash lines of each fluidics station in 1 liter of distilled water.

4. Choose Fluidics from the Run menu. Alternatively, click the down arrow Protocol list 
on the toolbar.

5. Choose Bleach for the respective modules in the Protocol drop-down list.

6. Disengage washblock for each module.

7. Connect one end of the plastic tubing to the needle at the bottom of each module and 
insert the other end into 0.525% sodium hypochlorite solution (at least 200 mL for all 
four modules).

8. ENGAGE washblock. The fluidics station will empty the lines and perform three 
cleaning cycles of 10 rinses each using bleach solution.

9. When the fluidics station LCD window displays Remove Tube from Needle, carefully 
remove tubing from each module needle by pushing the tubing down with one hand 
while holding the needle with the other.

10. Load empty microcentrifuge tube onto each module. The fluidics station will empty the 
lines and run three cycles with three rinses each. In addition, the fluidics station will 
rinse the needle 20 times, twice using distilled water, then bring the temperature back 
to 25°C and drain the lines with air.

11. The LCD display will read CLEANING DONE.

Each fluidics station with four modules requires at least 200 mL of the 0.525% 
sodium hypochlorite solution.

The BLEACH protocol requires at least 550 mL of distilled water.

Temperature will ramp up to 50°C.

Do not pull the tube as this may damage the needle in the process.
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Monthly Fluidics Station 
Decontamination Protocol

To maintain your Fluidics Station in the best possible working condition, we recommend 
that the following decontamination protocol be performed on your fluidics station at least 
once a month, in addition to the weekly cleaning described above. The protocol requires 
approximately 2 hours to run. 

This protocol ensures that all of the tubing associated with the station is kept thoroughly 
clean. Keeping this tubing as clean as possible ensures that array images will be optimized 
and high quality results will be obtained. 

1. Prepare 2 liters of 0.525% sodium hypochlorite solution using distilled water. Mix 
well.

2. Place all three wash lines of the fluidics station in 1 liter of 0.525% sodium 
hypochlorite solution.

3. Run the Prime protocol (page 2.4.8) on all four modules with wash lines in 0.525% 
sodium hypochlorite solution (instead of wash buffers A and B).

4. Run the Shutdown protocol (page 2.4.16) on all four modules with wash lines in 
0.525% sodium hypochlorite solution (instead of distilled water).

5. Follow Bleach Protocol (as described on page 5.1.4) with the following change in 
Step 3: place the three wash lines of the fluidics station in 1 liter of 0.525% sodium 
hypochlorite solution instead of distilled water.

6. Change intake tubing and peristaltic tubing, if required (as described in the Affymetrix 
GeneChip® Fluidics Station 400 User’s Guide). 

7. Run the Bleach protocol with three wash lines of the fluidics station in distilled water.

8. Run the Prime protocol with wash lines in distilled water (instead of wash buffers A 
and B).

9. Run the Shutdown protocol with wash lines in distilled water.

10. Run the Prime protocol with wash lines in distilled water (instead of wash buffers A 
and B).

11. Run the Shutdown protocol with distilled water.

At the end of each step, the fluidics station will indicate a ‘ready’ status. The fluidics 
station should not be used until this entire procedure (steps 1-11) is complete.
5.1.5
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6.A.4
Affymetrix Technical Support

Affymetrix provides technical support via phone or Email. To contact Affymetrix Technical 
Support:

Affymetrix Inc.

3380 Central Expressway
Santa Clara, CA 95051
USA

Tel: 888-362-2447 (888-DNA-CHIP)
Fax: (408) 731-5441
Email: support@affymetrix.com

Affymetrix UK, Ltd.,

Voyager, Mercury Park,
Wycombe Lane,Wooburn Green,
High Wycombe HP10 0HH
United Kingdom

Tel: +44 (0)1628 552550
Fax: +44 (0)1628 552585
Email: supporteurope@affymetrix.com

www.affymetrix.com

http://www.affymetrix.com
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Supplier Contact Information

Supplier US United Kingdom France Germany

Ambion
www.ambion.com

(800) 888-8804 +44 (0)1993 706 500 +33 (0)1 42 53 14 53 +49 (0)692 88082

Amersham/Pharmacia 
Biotech
www.apbiotech.com

(800) 323-9750 +44 (0)800 515 313 +33 (0)1 69 35 67 00 +49 (0)761 49030

Amresco
www.amresco-inc.com

(800) 448-4442 +44 (0)1582 745 000 +33 (0)4 70 03 88 55 +49 (0) 551 506860

ATCC
www.atcc.org

(800) 638-6597 US (703) 365-2700

BioWhittaker
www.brinkman.com

(800) 638-8174 +44 (0)1189 795 234 (Belgium) +32 8-732-1611

Brinkman Instrument
www.coleparmer.com

(800) 421-9988 see web site for nearest distributor

Cole-Parmer
www.coleparmer.com

(800) 323-4340 +44 (0)1815 747 556 +33 (0)3 88 67 14 14 +49 (0)785 17069

CLONTECH
www.clontech.com

(800) 662-CLON +44 (0)1256 476 500 +33 (0)1 34 60 24 24 +49 (0)622 134170

Epicentre Technologies
www.epicentre.com

(800) 284-8474 +44 (0)1223 366 500 +33 (0)1 30 46 39 00 +49 (0)515 29020

Eppendorf - 5 Prime
www.5prime.com

(800) 533-5703 US (303) 440-3705

FMC Bioproducts
www.fmc.com

US (215) 299-6000

GENSET Corp
www.genset.com

(800) 995-0308 +33 (0)1 43 56 59 00

Invitrogen Life 
Technologies
www.invitrogen.com

(800) 955-6288 00 800 5345 5345 (Toll-free for Europe)

Millipore Corp
www.millipore.com

(800) 645-5476 +44 (0)1923 816 375 +33 (0)1 30 12 70 00 +49 (0)619 64940

Molecular Probes
www.probes.com

(541) 465-8300 +44 (0)1223 316 855 +33 (0)4 70 03 88 55 +49 (0)551 371062

New England Biolabs
www.neb.com

(800) 632-5227 +44 (0)800 318 846 +33 (0)1 34 60 24 24 +49 (0)800 2465 227

Novagen
www.novagen.com

(800) 207-0144 +44 (0)800 622 935 +33 (0)1 30 46 39 00 +49 (0)800 6931 000

Operon Technologies
www.operon.com

(800) 688-2248 +44 (0)1914 100 323 see web site for nearest distributor

Pierce Chemical
www.piercenet.com

(800) 874-3723 +44 (0)1244 382 525 +33 (0)4 70 03 88 55 +49 2241 96850

Promega Corporation
www.promega.com

(800) 356-9526 +44 (0)800 378 994 +33 (0)8 00 48 79 99 +49 (0)621 85010

QIAGEN
www.qiagen.com

(800) 426-8157 +44 (0)1293 422 911 +33 (0)1 60 92 09 20 +49 (0)210 3892 230
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httP://www.ambion.com
http://www.apbiotech.com
http://www.atcc.org
http://www.biowhittaker.com
http://www.coleparmer.com
http://www.clontech.com
http://www.brinkman.com
http://www.fmc.com
http://www.gensetoligos.com/
http://www.millipore.com
http://www.probes.com
http://www.novagen.com
http://www.piercenet.com/
http://www.promega.com
http://www.qiagen.com
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http://www.epicentre.com
http://www.invitrogen.com
http://www.neb.com
http://www.operon.com
http://www.5prime.com
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6.A.6
Rainin 
www.rainin.com

(800) 472-4646 +44 (0)1582 456 666 see web site for nearest distributor

Roche Molecular 
Biochemical 
biochem.roche.com

(800) 262-1640  +44 (0)1273 480 444 +33 (0)4 76 76 30 87 +49 (0)621 75985 68

Sigma-Aldrich
www.sigma-aldrich.com

(800) 325-3010 +44 (0)1202 733 114 +33 (0)4 74 82 28 88 +49 (0)896 5131130

USA Scientific
www.usascientific.com

(800) 522-8477 US (352)-237-6288

Vector Laboratories
www.vectorlabs.com

(800) 227-6666 +44 (0)1733 237 999 44 86 22 75 +49 (0)9342 39499 or 
0800 253 9472

VWR Scientific Products
www.vwrsp.com

(800) 932-5000 US (908) 757-4045

Supplier US United Kingdom France Germany

http://www.rainin.com
http://biochem.roche.com
http://www.sigma-aldrich.com
http://www.usascientific.com
httP://www.vectorlabs.com
http://www.vwrsp.com
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Reagent List

A
Acetic Acid, Glacial, Sigma-Aldrich, P/N A 6283
Acetylated Bovine Serum Albumin (BSA) solution, 50 mg/mL, Invitrogen Life Technologies, 

P/N 15561020
Ammonium Acetate, 7.5 M, Sigma-Aldrich, P/N A 2706
Anti-streptavidin antibody (goat), biotinylated, Vector Laboratories, P/N BA-0500
Antibody (goat), Anti-streptavidin, biotinylated, 0.5 mg, Vector Laboratories, P/N BA-0500
Antibody, IgG, Goat, Reagent Grade, 50 mg, Sigma-Aldrich, P/N I5256
γ-S-ATP, 20 µmoles, Roche Molecular Biochemical, P/N 1162306

B
Bleach (5.25% Sodium Hypochlorite), VWR Scientific Products, P/N 21899-504
Bovine Serum Albumin (BSA) solution, 50 mg/mL,  Acetylated, Invitrogen Life Technologies,

P/N 15561020

C
CHROMA SPIN-100 Columns in Swing Bucket Format, CLONTECH, P/N K1302-1
Control Oligo B2, 30 nM, Affymetrix, P/N 900301

D
dATP, dCTP, dGTP, dTTP, Amersham Pharmacia Biotech, P/N 27-2035-01
Deoxyribonuclease I (DNase I), Amersham Pharmacia Biotech, P/N 27-0514-01
DMSO, Hybrid-Max®, Sigma-Aldrich, P/N D2650
DNA, Herring Sperm, Promega Corporation, P/N D1811
DNA Ligase, E. coli, Invitrogen Life Technologies, P/N 18052-019
DNA Polymerase, E. coli, Invitrogen Life Technologies, P/N 18010-025
DNA Polymerase, T4,  Invitrogen Life Technologies, P/N 18005-025
dNTP, 10 mM, Invitrogen Life Technologies, P/N 18427-013
DTT, 100 mM, Epicentre Technologies, P/N M4410K (supplied with MMLV Reverse Transcriptase)

E
EDTA Disodium Salt, 0.5 M solution, 100 mL, Sigma-Aldrich, P/N E7889
EDTA, 0.05 M, pH 8.0, Invitrogen Life Technologies, P/N 15575-038
Enzo BioArray HighYield RNA Transcript Labeling Kit, Affymetrix, P/N 900182
Ethidium Bromide, Sigma-Aldrich, P/N E 8751
Expression Control Clones, American Type Culture Collection (ATCC)

pGIKS-bioB ATCC 87487
pGIKS-bioC ATCC 87488
pGIKS-bioD ATCC 87489
pGIKS-cre ATCC 87490
pGIBS-lys ATCC 87482
pGIBS-phe ATCC 87483
6.A.7 A
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http://www.sigma-aldrich.com
http://www.affymetrix.com
message URL http://www.apbiotech.com
message URL http://www.apbiotech.com
http://www.atcc.org
http://www.clontech.com
http://www.epicentre.com
http://www.invitrogen.com/
http://www.invitrogen.com/
http://www.promega.com
http://www.invitrogen.com/
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
httP://www.vectorlabs.com
httP://www.vectorlabs.com
http://www.invitrogen.com/
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://biochem.roche.com/
http://www.invitrogen.com/
http://www.invitrogen.com/
http://www.affymetrix.com
http://www.vwrsp.com
http://www.invitrogen.com/
http://www.sigma-aldrich.com
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pGIBS-thr ATCC 87484
pGIBS-trp ATCC 87485
pGIBS-dap ATCC 87486

G
GeneChip® Hybridization Oven 640,  Affymetrix,  P/N 800139
GeneChip® Eukaryotic Hybridization Control Kit, Affymetrix, P/N 900299
Glycogen, Ambion, P/N 9510
Glycogen, 20 mg/mL, Roche Molecular Biochemical, P/N 901393
Goat IgG, Reagent Grade, Sigma-Aldrich, P/N I5256

H
HCl, 1N solution, VWR Scientific Products, P/N MK638860
Herring Sperm DNA, Promega Corporation, P/N D1811

I
ImmunoPure® NeutrAvidin, Pierce Chemical, P/N 31000
ImmunoPure® Streptavidin, Pierce Chemical, P/N 21125

L
10 bp and 100 bp ladder, Invitrogen Life Technologies, P/N 10821-015 and15628-019, respectively

M
Magnesium acetate (MgOAc), Sigma-Aldrich, P/N M2545
MasterPure™ RNA Purification Kit, Epicentre Technologies, P/N MCR85102
MEGAscript T3 Kit, Ambion, P/N 1338
MEGAscript T7 Kit, Ambion, P/N 1334
MES Free Acid Monohydrate SigmaUltra, Sigma-Aldrich, P/N M5287
MES Sodium Salt, Sigma-Aldrich, P/N 5057
MMLV Reverse Transcriptase,  New England BioLabs, P/N M0253L
MMLV Reverse Transcriptase Buffer, 10X, New England BioLabs, P/N M0253L
MOPS, Sigma-Aldrich, P/N M3183

N
NaCl, 5 M, RNase-free, DNase-free, Ambion, P/N 9760G
NaOH, 1N Solution, VWR Scientific Products, P/N MK469360
Novex XCell SureLock™ Mini-Cell, Invitrogen Life Technologies, P/N EI9001
Nuclease-free Water, Ambion, P/N 9930
Nucleotides, labeled, Biotin-11-CTP and Biotin-16-UTP, Enzo, P/N 42818 (CTP) and 

P/N 42814 (UTP)
Nucleotides, Biotin-11-CTP, Sigma-Aldrich, P/N B7048
Nucleotides, Biotin-16-UTP, Roche Molecular Biochemicals, P/N 1388908
Nucleotides, Biotin-16-UTP, Sigma-Aldrich, P/N B6923

http://www.ambion.com
http://www.ambion.com
http://www.ambion.com
http://www.ambion.com
http://www.enzo.com
http://www.epicentre.com
http://www.neb.com
http://www.neb.com
http://www.invitrogen.com/
http://www.piercenet.com/
http://biochem.roche.com/
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.invitrogen.com/
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://biochem.roche.com/
http://www.promega.com
http://www.affymetrix.com
http://www.affymetrix.com
http://www.vwrsp.com
http://www.ambion.com
http://www.vwrsp.com
http://www.piercenet.com/
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O
Oligo B2, Control, Control Oligo for the antisense probe array, HPLC purified

5´ -bio GTCGTCAAGATGCTACCGTTCAGGA- 3 ´
Oligotex Direct mRNA Kit, QIAGEN, P/N 72012, 72022, or 72041
Oligotex mRNA Kit, QIAGEN, P/N 70022, 70042, or 70061

P
PBS, pH 7.2,  Invitrogen Life Technologies,  P/N 20012-027
Pellet Paint, Novagen, P/N 69049-3 
PEO-Iodoacetyl-Biotin, 50 mg, Pierce Chemical, P/N 21334ZZ
Phase Lock Gel, Brinkman Instrument, P/N 0032007961 for 200
Phenol/chloroform/isoamyl alcohol, Ambion, P/N 9732 
Phycoerythrin-Streptavidin, Molecular Probes, P/N S-866
Polynucleotide Kinase, T4, New England BioLabs, P/N 201L
Potassium acetate (KOAc), Sigma-Aldrich, P/N P5708
Primer, T7– (dT)24, (Genset Corp), HPLC purified
5´ - GGCCAGTGAATTGTAATACGACTCACTATAGGGAGGCGG-(T)24 - 3´

Q
Qiashredder, QIAGEN, P/N 79654

R
R-Phycoerythrin Streptavidin, Molecular Probes, P/N S-866
Ready-Lyse™ Lysozyme Solution, Epicentre Technologies, P/N R1802M
Ribonuclease H (RNase H), E. coli, Epicentre Technologies, P/N R0601K
RNA/DNA Mini Column Kit, QIAGEN, P/N 14123
RNase H, E. coli, Invitrogen Life Technologies, P/N 18021-021, or Epicentre Technologies, 

P/N R0601K
RNeasy Mini Kit, QIAGEN, P/N 74104, 74106

S
Second strand buffer, 5X,  Invitrogen Life Technologies, P/N 10812-014
Separator, Micropure, Millipore, P/N 42512
Sodium Acetate, 3 M, pH 5.2, Sigma-Aldrich, P/N S7899
Sodium Hypochlorite, Sigma-Aldrich, P/N 7681-52-9
SSPE, 20X, BioWhittaker, P/N 16-010Y
Streptavidin, ImmunoPure®, Pierce Chemical, P/N 21125
Sucrose Gel Loading Dye, 5X, Amresco, P/N E-274
SUPERase•In™, Ambion, P/N 2696
SuperScript II RT, Invitrogen Life Technologies, P/N 18064-071
SuperScript Choice system, Invitrogen Life Technologies, P/N 18090-019
SYBR Gold, Molecular Probes, P/N S-11494
SYBR Green II, FMC Bioproducts, P/N 50523, or Molecular Probes, P/N S7586
6.A.9 A
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http://www.ambion.com
http://www.amresco-inc.com
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http://www.epicentre.com
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http://www.novagen.com
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http://www.piercenet.com/
http://www.qiagen.com
http://www.qiagen.com
http://www.qiagen.com
http://www.qiagen.com
http://www.qiagen.com
http://www.sigma-aldrich.com
http://www.sigma-aldrich.com
http://www.invitrogen.com/
http://www.sigma-aldrich.com
http://www.neb.com
http://www.invitrogen.com/
http://www.epicentre.com
http://www.invitrogen.com/
http://www.ambion.com
http://www.invitrogen.com/
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T
TBE, 20X, BioWhittaker, P/N 16-012Y
TBE Gel (4-20%), 1.0 mm, 12 well, Invitrogen Life Technologies, P/N EC62252
TE, 1X, BioWhittaker, P/N 16-013B
Tough Spots, Label Dots, USA Scientific, P/N 9185
Tris pH 7.0, 1M, Ambion, P/N 9850G
Trizma Base, Sigma-Aldrich, P/N T 1503
TRIzol Reagent, Invitrogen Life Technologies, P/N 15596-018
Tubes, Sterile, RNase-free, microcentrifuge, 1.5 mL, USA Scientific, P/N 1415-2600
Tubing, Tygon, 0.04” inner diameter, Cole Palmer, P/N H-06418-04
Tween-20, 10%, Pierce Chemical, P/N 28320

V
Vacuum filter units 1 liter capacity, 0.20 µm or 0.45 µm, Corning, P/N 25988-1L

W
Water, DEPC-Treated, Ambion, P/N 9902
Water, Distilled, Invitrogen Life Technologies, P/N 15230-147
Water, Molecular Biology Grade, BioWhittaker, P/N 16-001Y

http://www.ambion.com
http://www.ambion.com
http://www.biowhittaker.com
http://www.biowhittaker.com
http://www.invitrogen.com/
http://www.invitrogen.com/
http://www.invitrogen.com/
http://www.piercenet.com/
http://www.sigma-aldrich.com
message URL http://www.usascientific.com
message URL http://www.usascientific.com
http://www.biowhittaker.com


p
e
n

d
ix

e
s

Section 6,  Appendix B
701044 rev 1 A
p



p
e
n

d
ix

e
s

FAQs & Troubleshooting

FAQs

This section contains frequently asked questions related to GeneChip® Expression Analysis.

Sample Preparation

What is the minimum amount of total RNA I can use for each microarray 
experiment?

We currently recommend 5 ug of total RNA for our eukaryotic expression arrays. There are 
protocols in the literature which describe the use of less starting material for hybridization 
onto Affymetrix® GeneChip® arrays, but we have not fully validated the performance of 
these various labeling strategies compared with our standard protocol.

What is the least amount of labeled eukaryotic cRNA target I can put on an array?

You should always use the recommended quantity of cRNA as described in this manual. 
Please refer to Table 2.3.1 for the detailed instruction on the amount of cRNA needed for 
different array formats. Though there is a tolerance for some variation in this quantity, we 
have found that hybridization of significantly less cRNA will result in reduced sensitivity, 
particularly for low-copy number messages. 

How long can I store my eukaryotic cRNA target after its first hybridization?

Assuming that there is no RNase contamination, cRNA targets can be stored for at least one 
year at –80°C without significant loss of signal intensity. The fact that the cRNA has been 
fragmented prior to the first hybridization reduces any effects of subsequent degradation.

Hybridization, washing and staining

How long can I keep my arrays in low stringency wash buffer before scanning?

The arrays may be stored in the dark for up to 8 hours, at 4º C prior to scanning with no 
noticeable loss of signal intensity. To avoid condensation while scanning, warm the arrays 
to room temperature prior to the scan.

How many times can I scan an array before the data is affected?

It is always best to capture the data on the initial scan. The laser light used in scanning can 
bleach the fluorophore and will result in reduction in signal intensity of 10-20% with each 
scan. Therefore, subsequent scans will not give signals as robust as the initial scan.
701044 rev 1 6.B.3 A
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How often do I need to do maintenance on the fluidics station?

With normal use (e.g., 20 arrays/module/week), we recommend the following schedule: 
Every week, the needle bleaching protocol should be performed; on a monthly basis, the 
full-fluidics bleaching protocol should be performed and the peristaltic-pump tubing 
replaced. Please refer to Section 5, Fluidics Station Maintenance Procedures, for more 
detail.

What fluidics script do I use?

The appropriate fluidics script is specific to the array format (standard, midi, mini or micro) 
and the organisms (eukaryotic or E. coli). Information on the array format and appropriate 
script is contained in the package insert that comes with each array package.  Please refer to 
the hybridization protocols in the respective sections of this manual for more detail.

I have a bubble in the array. How do I get rid of it?

After the final wash on the fluidics station, if the door is still open, replace the array and 
close the door. The fluidics module will automatically run a drain and fill protocol with 
buffer A. If one cycle does not remove the bubble, repeat the process and try again. If this 
doesn’t work or the door has already been closed, manually drain the array and refill with 
buffer A.

What are the safe stopping points in the assay?

It is safe to stop work after each of the major steps in the sample preparation process: 
1st strand cDNA synthesis, 2nd strand synthesis, IVT, fragmentation, or after mixing the 
hybridization mix cocktail. If possible, work with extracted RNA samples immediately 
rather than freezing them. Although it is common practice to use stored frozen RNA 
samples in the process, and such samples properly stored routinely give good results, 
eliminating a freeze-thaw can be of benefit since it will most likely yield higher quality 
RNA. 

Data analysis

GeneChip Microarray Suite is on the C: drive and its filling up. How can I create 
more room on the hard drive?

The library and data files can be moved to another drive then deleted from the C: drive. 
After moving the files, remember to change your library file default settings in MAS to the 
appropriate directory by clicking on the Tools tab and then select Defaults in the drop-
down menu, then File locations tab in the Defaults window.

What is the difference between scaling and normalization when I scale or normalize 
my data to all genes on the array?

With scaling, you create an arbitrary target average intensity and scale the average intensity 
of all genes on each array within a data set to that number.  This enables you to compare 
multiple arrays within a data set.  The scaling factor remains the same for a particular array 
as long as you use the same arbitrary target intensity for scaling.  Scaling can be performed 
independent of the comparison analysis.

On the other hand, normalization can only be done when doing the comparison analysis.  It 
compares an experimental array with a baseline array and normalizes the average intensity 
of the experimental array to the average intensity of the baseline array when running a 
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comparison analysis in MAS.  The normalization factor for a particular array changes when 
you change the comparison baseline array. 

What are masks?

Masks represent a feature in MAS that is rarely used.  There are three types of mask files:

Image mask files: You may want to use an image mask if there is a large visible aberration 
on an image. You define the image mask based on the physical location on the image. Probe 
pairs included in the mask are excluded from the analysis. Image masks are associated with 
a given .dat/.cel file and cannot be used on other images.

Probe mask files: Probe masks are defined by the probe set and probe pair number. Probe 
pairs included in this type of probe mask are excluded from the analysis when the probe 
mask is used. Probe masks can be applied across a data set. Please refer to Section 4, Data 
Analysis, for more detailed description.

A second type of probe mask defines a select group of probe sets that can be used in 
normalization or scaling. Please refer to Affymetrix® Microarray Suite User’s Guide where 
this type of probe set mask file is described.

If I realign the grid, how do I create a new .cel file?

If manual adjustment of the grid is necessary, the corresponding .cel file present at the time 
of adjustment will no longer be a valid representation of the realigned image data. 
Microarray Suite will automatically detect this situation either on initial reopening of the 
readjusted .dat file or during the analysis process. The user does not need to carry out any 
overt steps to accomplish this. 

How do I add additional probe sets in the .rpt file?

Use the Report Settings dialog on the short cut menu in Microarray Suite to open the 
Expression Report. You may add any probe sets desired by simply typing in the probe set 
name(s) you wish to add (this can also be accomplished by cutting and pasting from a text 
file). Keep in mind that the probe set name must be entered exactly as it appears in the 
analysis file, including the suffixes such as “12345_s_at”.

Why can’t I analyze data files stored on a CD?

Files in CD-ROM format are stored in read-only mode.  MAS requires that this attribute be 
removed.  To do this, open NT Explorer and select the file(s) you copied from the CD.  
Click the right mouse button and select Properties.  Clear the Read-only check box near 
the bottom of the Properties screen and click OK.

How can the mismatch probe cell have a higher intensity than its complementary 
perfect match probe cell?

There could be a number of reasons for this. It is possible that this probe sequence could 
have high homology with another unknown sequence resulting in a high mismatch to 
perfect match ratio. Another possibility is that the probe sequence on the array is correct for 
the majority of the cases, however, the sample may have a sequence variation which causes 
low specific binding to the perfect match and high specific binding to the mismatch. 
Regardless of the cause of such phenomenon, the redundancy of the number of probes 
representing a sequence on GeneChip arrays negates any significant impact this may have 
on the final interpretation of the data.
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6.B.6
There are too many files showing in the file window in Microarray Suite. What can I 
do?

By placing files for projects in their own directories and changing the default settings for 
data in Affymetrix® Microarray Suite appropriately, you can manage large numbers of files. 

In addition, with the Windows NT operating system, users can specify their own directory 
defaults in Microarray Suite while logging on and create their own directories containing 
their data. To do so, each user should have their own logon name and organize files in 
subdirectories, for example, by project, user, date or lab. Each user can then set the data 
default to their subdirectory of choice.

Experimental design

Which is greater, sample or assay variability?

Sample variability that arises mainly from biological heterogeneity is certainly higher than 
assay variability, and has been estimated to be at least 10-fold greater than assay variability. 
We recommend that researchers run multiple samples per data point to account for sample-
to-sample variability.  In addition, take care in experimental design to minimize potential 
variables associated with sample variables.
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Troubleshooting

Problem Likely Cause Solution

Sample Quality

High 3’/5’ ratio Most often caused by degradation of the RNA 
during the isolation process.

Start with a fresh sample and minimize the 
possibility of RNase activity. Recovered RNA should 
demonstrate the ribosomal bands on a non-
denaturing agarose gel.

Low cRNA yield Low RNA quality, which interferes with reverse 
transcription and subsequent labeling.

It sometimes helps to do a Trizol-based isolation 
followed by clean-up with an RNeasy column. For 
samples with a high lipid content such as brain, use 
procedures to reduce the lipid content prior to the 
reverse transcription reaction.

Image / Array Quality

Dim Corners In need of fluidics maintenance. Bleach the fluidics as recommended and change the 
peristaltic pump tubing. If the problem persists, call 
Affymetrix Technical Support.

Dim Arrays Hybridization problems. Check the signal from control Oligo B2 to see if the 
signals are also weak.  If it appears to be a 
hybridization issue, check all hybridization reagents 
and equipment setting before running another 
assay. Test arrays can be useful for troubleshooting 
this issue.

Sample preparation problems. Re-check each of the quality control procedures 
recommended in the manual, such as absorbance 
measurement and running an aliquot on gel to 
ensure that there is no significant loss of sample 
during target preparation due to manipulation of the 
sample or RNase contamination.
Also see above for “low cRNA yield”.

Leaking septa Leaking septa are most often created during 
the array filling with a pipette.

Be sure to use pipette tips without a beveled end. 
When filling the arrays, be careful to push the 
pipette tip straight through the septum and maintain 
a constant perpendicular angle during filling and 
draining the array.

Software Problems

In MAS, I received the error 
message, “Could not find the 
.cif file”.

The default path for the library files in MAS is 
incorrect.

Set the correct path for the library files.

The library files for those specific arrays are not 
loaded on the computer.

Load the library files for that array, making sure to 
check the box appropriate for that array during the 
loading process.

The probe array type is missing 
from the pull-down menu when 
creating an .exp file.

The default path for the library files in MAS is 
incorrect.

Set the correct path for the library files.

The library files for those specific arrays are not 
loaded on the computer.

Load the library files for that array, making sure to 
check the box appropriate for that array during the 
loading process.

The fluidics protocols are 
missing from the pull-down 
menu in the Fluidics control 
window.

The default path for the protocol files in MAS is 
incorrect.

Check that the location of the fluidics files on the 
hard drive corresponds to the default protocol path 
in MAS.

The library files are not loaded on the computer. Load the library files, making sure the protocols are 
in the same directory as the default path set in 
MAS. 
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6.B.8
Software Problems (continued)

Descriptions do not appear in 
the analysis window following 
networking of the computer and 
there is also a SQL error 
message appearing.

When networking computers, the name of the 
computer is often changed to correspond to an 
organization’s standard conventions. This 
results in the breaking of the connection 
between MAS and the Microsoft Data Engine 
that also requires the computer name to 
operate.

After the computer is renamed, uninstall MAS and 
MSDE and reinstall MAS.

GeneChip® Analysis Suite is on 
the C: drive and its filling up.

The library and protocol files can be moved to 
another, larger drive. The folders can simply be 
dragged and placed in a directory on another drive. 
Remember to change the default path for the library 
and protocol files in MAS, and remember that this 
path will need to be modified for each log in name. 
In addition, GeneChip data should always be stored 
locally on the largest available drive on the 
workstation.

The gene descriptions show up 
for some users and not for 
others.

This is a result of different security settings 
between users and administrators of the 
workstation.

Call Affymetrix Technical Support for information on 
how to change the registry to correct this.

Problem Likely Cause Solution
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List of Controls on GeneChip® Probe Arrays

Table 6.C.1

Control Genes on GeneChip® Microarrays

Array Type
Origin of 

Organism 

Control Gene 

Name
Utility for GeneChip® Experiments

Associated 

Affymetrix 

Products

Eukaryotic 

Arrays

synthetic B2 Oligo Landing lights. Control Oligo B2, P/N 
900301

Section 2, Chapter 2 
and Chapter 3

E.coli bioB
bioC
bioD

Anti-sense biotinylated cRNA probes are used as 
hybridization controls.

GeneChip Eukaryotic 
Hybridization Control 
Kit, 
P/N 900299

Section 2, Chapter 3

P1 Bacteriophage cre Anti-sense biotinylated cRNA probes are used as 
hybridization controls.

B. subtilis dap
thr
trp
phe
lys

Poly(A)+-tailed sense RNA can be produced by IVT 
and spiked into isolated RNA samples as controls 
for the labeling and hybridization process. The 
spikes can also be used to estimate assay 
sensitivity.

N/A

Section 2, Chapter 2

GeneChip® 

E.coli Genome 

Array

synthetic B2 Oligo Landing lights. Control Oligo B2, P/N 
900301

Section 3, Chapter 3

B.subtilis dap
thr
trp
phe
lys

Sense RNA can be produced by IVT and spiked 
into purified sample RNA as control for the 
labeling and hybridization process. The spikes can 
also be used to estimate assay sensitivity.

N/A

Section 3, Chapter 2 
and Chapter 3
701045 rev 1 6.C.3 A
p


	GeneChip Expression Analysis Technical Manual
	Registration
	Contents
	Section 1: Overview
	Ch 1: GeneChip® Expression Analysis Overview
	Introduction and Objectives
	Explanation of GeneChip® Probe Arrays
	GeneChip® Expression Analysis Overview
	Step 1: Target Preparation
	Step 2: Target Hybridization
	Step 3: Experiment and Fluidics Station Setup
	Step 4: Probe Array Washing and Staining
	Step 5: Probe Array Scan
	Step 6: Data Analysis

	Precautions
	Terminology
	Interfering Conditions
	Instruments
	References
	Limitations


	Section 2: Eukaryotic Sample and Array Processing
	Ch 1: Eukaryotic Target Preparation
	Reagents and Materials Required
	Total RNA Isolation
	Poly (A)+ mRNA Isolation
	cDNA Synthesis
	Synthesis of Biotin-Labeled cRNA
	IVT cRNA Cleanup and Quantitation
	cRNA Fragmentation
	Miscellaneous Reagents
	Miscellaneous Supplies

	Reagent Preparation
	5X RNA Fragmentation Buffer (200 mM Tris-acetate, pH 8.1, 500 mM KOAc, 150 mM MgOAc)

	Isolation of RNA
	Isolation of RNA From Yeast
	Total RNA
	Poly(A)+ mRNA

	Isolation of RNA from Arabidopsis
	Total RNA
	Poly(A)+ mRNA

	Isolation of RNA from Mammalian Cells or Tissues
	Total RNA
	Poly(A)+ mRNA

	Precipitation of RNA
	Total RNA
	Poly(A)+ mRNA
	Precipitation Procedure
	*Addition of Carrier to Ethanol Precipitations

	Quantitation of RNA

	Synthesis of Double-Stranded cDNA From Purified Poly(A)+ mRNA1
	T7-(dT)24 primer:
	Step 1: First Strand cDNA Synthesis
	Step 2: Second Strand cDNA Synthesis

	Synthesis of Double-Stranded cDNA from Total RNA
	T7-(dT)24 primer
	Step 1: First Strand cDNA Synthesis
	Step 2: Second Strand cDNA Synthesis

	Cleanup of Double-Stranded cDNA
	Step 1: Phase Lock Gels (PLG)-Phenol/Chloroform Extraction
	Step 2: Ethanol Precipitation

	Synthesis of Biotin-Labeled cRNA
	Cleaning Up and Quantifying In Vitro Transcription (IVT) Products
	Step 1: In Vitro Transcription Clean Up
	Recommended Methods for In Vitro Transcription Clean Up
	IVT Cleanup Protocol Using Qiagen RNeasy Columns
	Suggestions for Increased Yield
	IVT Cleanup Protocol Using Chroma spin-100s and Ethanol Precipitation

	Step 2: Ethanol Precipitation
	Step 3: Quantifying the cRNA (IVT Product)
	Step 4: Checking Unfragmented Samples by Gel Electrophoresis

	Fragmenting the cRNA for Target Preparation

	Ch 2: Preparation of Controls for Eukaryotic Arrays
	Reagents and Materials Required
	GeneChip® Eukaryotic Hybridization Control Kit (Complete Kit)
	Poly(A)+ Spike Controls

	Hybridization Control Kit
	Poly(A)+ Spike Controls

	Ch 3: Eukaryotic Target Hybridization
	Reagents and Materials Required
	Miscellaneous Reagents
	Miscellaneous Supplies

	Reagent Preparation
	12X MES Stock
	2X Hybridization Buffer

	Eukaryotic Target Hybridization

	Ch 4: Eukaryotic Arrays: Washing, Staining and Scanning
	Reagents and Materials Required
	Miscellaneous Supplies

	Reagent Preparation
	Stringent Wash Buffer
	Non-Stringent Wash Buffer
	2X Stain Buffer
	10 mg/mL Goat IgG Stock

	Experiment and Fluidics Station Setup
	Step 1: Defining File Locations
	Step 2: Entering Experiment Information
	Step 3: Preparing the Fluidics Station
	Setting Up the Fluidics Station
	Priming the Fluidics Station


	Probe Array Wash and Stain
	Washing and Staining Procedure 1: Single Stain for Eukaryotic Targets
	Preparing the SAPE Stain Solution
	Washing and Staining the Probe Array

	Washing and Staining Procedure 2: Antibody Amplification for Eukaryotic Targets
	Preparing the Staining Reagents
	SAPE Stain Solution
	Antibody Solution
	Washing and Staining the Probe Array


	Probe Array Scan
	Shutting Down the Fluidics Station
	Customizing the Protocol


	Section 3: Prokaryotic Sample and Array Processing
	Ch 1: Direct Labeling of Enriched E. coli mRNA
	Introduction
	mRNA Enrichment Procedure
	RNA Fragmentation and Labeling Procedure

	Reagents and Materials Required
	Total RNA Isolation
	mRNA Enrichment Procedure
	RNA Fragmentation and Labeling Reaction
	Gel-Shift Assay
	Miscellaneous Supplies

	Reagent Preparation
	mRNA Enrichment Procedure
	rRNA Removal Primer Stock
	25 mM dNTP Mix

	RNA Fragmentation and Labeling Reaction
	500 mM MOPS, pH 7.5

	Gel-shift Assay
	2 mg/mL NeutrAvidin


	Total RNA Isolation
	mRNA Enrichment Procedure
	Step 1: cDNA Synthesis
	Step 2: rRNA Digestion
	Step 3: cDNA Digestion

	RNA Fragmentation and Labeling Reaction
	Step 1: RNA Fragmentation
	Step 2: RNA 5´-Thiolation
	Step 3: Biotin Addition

	Gel-Shift Assay

	Ch 2: Preparation of Control Spike Transcripts for GeneChip® E. coli Genome Array
	Overview
	Reagents and Materials Required
	Miscellaneous Reagents

	Bacterial Plasmid DNA Preparation
	Linearization of Plasmid DNA Preparation
	Purification of Linearized Plasmid DNA
	In Vitro Transcription (IVT) to Produce Control Sense Transcripts
	Preparing the Control Transcript Mix

	Ch 3: E. coli Target Hybridization
	Reagents and Materials Required
	Miscellaneous Reagents
	Miscellaneous Supplies

	Reagent Preparation
	12X MES Stock
	2X Hybridization Buffer

	E. coli Target Hybridization

	Ch 4: GeneChip® E. coli Genome Array: Washing, Staining and Scanning
	Reagents and Materials Required
	Miscellaneous Supplies

	Reagent Preparation
	Stringent Wash Buffer
	Non-Stringent Wash Buffer
	2X Stain Buffer
	10 mg/mL Goat IgG Stock
	1 mg/mL Streptavidin Stock

	Experiment and Fluidics Station Setup
	Step 1: Defining File Locations
	Step 2: Entering Experiment Information
	Step 3: Preparing the Fluidics Station
	Setting Up the Fluidics Station
	Priming the Fluidics Station


	Probe Array Wash and Stain
	Preparing the Staining Reagents

	Probe Array Scan
	Shutting Down the Fluidics Station
	Customizing the Protocol


	Section 4: Data Analysis
	Ch 1: Data Analysis
	Overview
	GeneChip® Analysis Suite
	Analyzing Samples
	Comparison Analysis

	Affymetrix® Microarray Suite
	Expression Analysis Settings
	Viewing the Expression Analysis Settings

	Running an Absolute Expression Analysis
	Running a Comparison Expression Analysis
	Absolute Expression Analysis of the Baseline
	Comparison Expression Analysis of the Experiment and Baseline

	Microarray Suite Default Settings Dialog
	Probe Array Analysis

	Probe Pair and Probe Set Masking in GeneChip® Expression Analysis
	Probe Masking
	Creation and Use of Probe Mask Files
	Procedure to Create a Custom Probe Mask
	Defining the Probe Mask File Manually
	Using Cross Hyb..., Hyb... and Spike... to Generate Probe Mask Files
	Cross Hyb...
	Hyb…
	Spike…

	Probe Set Masking
	Creation and Use of Probe Set Mask Files

	File Types
	Probe Information Files
	Test Data Files



	Section 5: FS Maintenance
	Ch 1: Fluidics Station Maintenance Procedures
	Weekly Fluidics Station Cleanout
	Bleach Protocol

	Monthly Fluidics Station Decontamination Protocol


	Section 6: Appendixes
	A: Supplier Reference List
	Affymetrix Technical Support
	Supplier Contact Information
	Reagent List

	B: FAQs & Troubleshooting
	FAQs
	Sample Preparation
	What is the minimum amount of total RNA I can use for each microarray experiment?
	What is the least amount of labeled eukaryotic cRNA target I can put on an array?
	How long can I store my embryonic cRNA target after its first hybridization?

	Hybridization, washing and staining
	How long can I keep my arrays in low stringency wash buffer before scanning?
	How many times can I scan an array before the data is affected?
	How often do I need to do maintenance on the fluidics station?
	What fluidics script do I use?
	I have a bubble in the array. How do I get rid of it?
	What are the safe stopping points in the assay?

	Data analysis
	GeneChip Microarray Suite is on the C: drive and its filling up. How can I create more room on th...
	What is the difference between scaling and normalization when I scale or normalize my data to all...
	What are masks?
	If I realign the grid, how do I create a new .cel file?
	How do I add additional probe sets in the .rpt file?
	Why can’t I analyze data files stored on a CD?
	How can the mismatch probe cell have a higher intensity than its complementary perfect match prob...
	There are too many files showing in the file window in Microarray Suite. What can I do?

	Experimental design
	Which is greater, sample or assay variability?


	Troubleshooting

	C: List of Controls on GeneChip® Probe Arrays



